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Working with Unifier Programs, Shells, and 
Projects 

The following explains how to work with Unifier programs, shells, and projects. 

Within our documentation, some content might be specific for cloud deployments while other 
content is relevant for on-premises deployments. Any content that applies to only one of these 
deployments is labeled accordingly. 

In This Section 

Unifier Programs ....................................................................................................... 7 
Unifier Shells ........................................................................................................... 11 
Unifier Projects ........................................................................................................ 57 
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Unifier Programs 

Cost data from different projects or CBS code-based shells can be rolled up into a program. The 
roll up lets you view and compare member project and shell data in a cash flow worksheet or 
cost sheet, and in the company's base currency. 

Base currency: Projects and shells can use different currencies. Unifier converts all project and 
shell currencies to the company's base currency and presents the rolled up data in the base 
currency using the earliest exchange rate defined for the period. You can create a snap shot of 
this data for later reference. For information about working with snapshots refer to Unifier 
Managers User Guide. 

This data is reportable. For more information about user-defined reports (UDRs), refer to Unifier 
General User Guide. 

Refresh: When there are changes to the program roll up, either additions or removals of projects 
or shells, refreshing the worksheet updates the cash flow curve. 

Program membership: Program administrators determine program membership. 

 If you are a member of a project or CBS shell that is part of a program, you may be a 
member of that program. 

 You can also be a member of a program without being a member of a project or shell. 

Company membership: As a Unifier user, you may be part of a sponsor company or a partner 
company (or possibly both). 

 Sponsor companies can commission and administer projects or shells and programs. 

 Partner, or member, companies (e.g., subcontractors, vendors) work with sponsor 
companies. 

In This Section 

Open a program ........................................................................................................ 7 
What you can do in a Program .................................................................................. 8 
Working with the Program Summary ......................................................................... 8 

Open a program 

Open a program to access the program level functions. 

To open a program 

1) Go to the Program tab and switch to User mode. The Programs log opens and lists any 
programs to which you have access. 

2) Select the program you want to see and click Open (or double-click the program). 

3) In the left Navigator, select the module for which you want to see the data roll up of included 
projects or shells. 
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What you can do in a Program 

Depending upon the modules your company has set up and your access permissions, the 
following program functions are available in the left Navigator. 

 Summary: Provides a snapshot of program information for the company. You can 
choose the Summary - Standard View or customize your summary page (Summary - 
User View). 

 Cost Manager: Access program-level Cost Manager functions: cost sheet and cash flow. 
View project and shell data in the company's base currency. Refer to Unifier Managers 
User Guide for details. 

 Schedule Manager: Summarizes project or shell schedule data as it is rolled up to the 
program level. Refer to Unifier Managers User Guide for details. 

 Reports: For creating and generating program-level user-defined reports. Refer to Unifier 
General User Guide for details. 

Working with the Program Summary 

The program summary provides a snapshot of the overall program. There are two available 
views: 

 Summary - Standard View: System-generated summary that summarizes program 
information. 

 Summary - User View: You can customize the program summary to display virtually any 
reportable project or shell related information in table or graphical format. The summary 
information is pulled from summary-type user defined reports or from pre-configured 
standard data type reports. 

To access the program summary 

1) Go to the Standard Projects tab and switch to User mode. 

2) Click Programs in the left Navigator. 

3) On the log, open a program, then click Summary in the left Navigator. 

4) Click the View menu and choose Standard to view the Summary - Standard View or User
to view the user-defined view (Summary - User View). 

The standard view of the program summary displays an overview of the program. 

To print the program summary 

1) Go to the Standard Projects tab and switch to User mode. 

2) Click Programs in the left Navigator. 

3) On the log, open a program, then click Summary in the left Navigator. 

You can print both the user view and the standard view of the program summary. 

4) From the File menu, click Print Preview. The preview window of the summary opens. 

5) Click the Print icon in the upper right corner of the window. 
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Configure a program summary 

Like the project or shell summary, you can customize the information that is displayed on the 
Program Summary window by defining blocks. 

To add reports to the user view 

1) Go to the Standard Projects tab and switch to User mode. 

2) Click Programs in the left Navigator. 

3) On the log, open a program, then click Summary in the left Navigator. The Summary 
window opens. 

4) Click the View menu and choose User. 

The initial reports included in the summary are displayed in table format. You have the option 
to modify how these reports display, remove them from the summary view, or add other 
summary reports. 

5) From the Edit menu, choose one of the following: 

 Left Column: To add information to the left side of the window 

 Right Column: To add information to the right side of the window 

The Left Column Blocks or Right Column Blocks window opens. 

6) Do one of the following: 

 To add a user-defined summary report, click the Add Custom button. The Custom 
Summary Block window opens. Complete the window and click OK. 

 To add a pre-configured, standard data type report, click the Add Standard button. The 
Standard Summary Block window opens. Complete the window and click OK. 

The report will be added to the Blocks window. 

7) Click Close. The Program Summary - User View will update to include the new report. 

Available program-level reports

Name Drill down to 

<BP Name> Count by 
Status 

No drill down 

<BP Name>% by Status No drill down 

<BP Name> Count by 
Company 

No drill down 

<BP Name>% by 
Company 

No drill down 

<BP Name> Count by 
User 

No drill down 

<BP Name>% by Creator 
User 

No drill down 

<BP Name> - Tasks by 
User 

No drill down 
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<BP Name> - Tasks All 
Users 

No drill down 

Record Count per BP (for 
current user) 

No drill down 

Record% per BP No drill down 

Current User Task Count No drill down 

All User Task Count No drill down 

To manage blocks on the Program Summary - User View 

1) Go to the Standard Projects tab and switch to User mode. 

2) Click Programs in the left Navigator. 

3) On the log, open a program, then click Summary in the left Navigator. 

4) From the Edit menu, choose one of the following: 

 Left Column: To add information to the left side of the window 

 Right Column: To add information to the right side of the window 

The Blocks window opens. Blocks are listed in the order in which they appear on the page. 

5) To move a block, select it and click Move Up or Move Down. 

6) To delete a block, select it and click Delete. 

7) To change the display type, title, or other block property, select the block and click Open. 
Make changes as necessary and click OK. 
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Unifier Shells 

In Unifier, shells define your project collaboration workspace. Shells can represent whatever you 
want them to, for example: 

 Capital Projects 

 Maintenance Projects 

 Business Portfolios 

 Project Delivery Management 

With shells, you can show project relationships and hierarchies to more accurately represent a 
real-world physical or organizational structure. In the following example, indentation is used to 
represent levels in a hierarchy: 

 Region 

 Properties 

 Buildings 

 Buildings 

 Projects 

You can create multiple templates from which you can centrally manage large numbers of shells. 
The shells you create can have their own business processes, cost worksheets, reports, 
dashboards, document repositories, and users and groups. You can organize shells into project 
hierarchies that allow you to pull data from a current shell and any of its subordinate shells. 
Working together, these features give you visibility into, and control of, your projects. 

In This Section 

Shell Relationships and Hierarchy ........................................................................... 12 
Single Instance and Multiple Instance Shell Types .................................................. 12 
Shell and Cost Managers ........................................................................................ 13 
Shell Landing Page (Classic View) .......................................................................... 13 
Shell Landing Page (Standard View) ....................................................................... 16 
Shell Navigation ...................................................................................................... 19 
Shell Dashboard ...................................................................................................... 19 
Project Shell Dashboards ........................................................................................ 22 
Expand the Shell Log on the Landing Page ............................................................. 28 
About Shell Statuses ............................................................................................... 28 
Working with Shells ................................................................................................. 29 
Working with Gates and Phases .............................................................................. 50 
Integrating Activity Sheet for Multiple Shells ............................................................ 53 
Working with Multiple Document Manager Attribute Forms ..................................... 54 
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Shell Relationships and Hierarchy 

With shells, you can show project relationships and hierarchies to more accurately represent a 
real-world physical or organizational structure. Shell hierarchies can have as many levels as 
needed. For example: 

 Region (shell) 

 Properties (sub-shell) 

 Buildings (sub-shell) 

 Buildings (sub-shell) 

 Projects (sub-shell) 

In this simple hierarchy, the shell Region was created and named in uDesigner. The Region 
shell has the sub-shells Properties, Buildings, and Projects. The sub-shell Properties also has a 
sub-shell called Buildings. Subshell organization is configured in administration mode and 
managed through the shell detail form. 

Single Instance and Multiple Instance Shell Types 

Shells are characterized by: 

 A unique system ID 

 Single or multiple instance 

 Generic or CBS cost code 

Shell instances are copies of shell types, and have these characteristics: 

 An instance of a shell type must exist before the shell type is viewable in User Mode 

 Shell type single can be a root node or a tab 

 Shell type multiple populate levels in a hierarchy Shells and the Cost Managers 

Shells can be single or multiple instance. 

Single instance: This type of shell is an anchor shell and cannot be replicated. Use this shell at 
the root of a hierarchy. It is seen in Unifier as a tab, at the same level as the Home page. You 
cannot make a template of this shell. 

Multiple instance: This type of shell can be replicated. Use this shell as a building block for a 
hierarchy. Multiple-instance shells allow you to create more than one copy of a shell, and they 
support the use of templates. 

Here is an example of how it could work: Your anchor shell is a single-instance shell and might 
be called Europe. This shell has a tab, and is the root of the hierarchy. Under this shell, you 
could use multiple-instance shells to create shells that represent countries, such as Holland, 
France, and Hungary. These building block shells can have templates, so each of these country 
work spaces can have the same business processes and managers, but they may have different 
users. The Shell Manager enables you to import and manage shells. 

To access the hierarchy, click the anchor shell tab, as seen in the Tab Navigator. The shell 
landing page displays a mini log in which subordinate shells are listed in the shell log in the 
lower area of the landing page. 
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Shell and Cost Managers 

The uDesigner configuration controls shell relationships and also determines the type of cost 
manager that you can use with the shell. 

 Standard Cost Manager: Uses CBS codes and works with standard projects as well as with 
shells. In uDesigner, the administrator can create a shell that uses CBS costing. This shell 
then has the same Cost Manager as a standard project, but provides the configurability and 
hierarchical aspects of a shell. 

 Generic Cost Manager: Works with generic shells only. The Generic Cost Manager 
supports costing for projects that are not of a fixed duration or cost. This can include facilities 
management projects like: 

 Leases 

 Janitorial support 

 Building maintenance 

 Landscape care 

 Interior updates to a building 

The ongoing management of a building does not have a start and end, and you cannot always 
project the ultimate cost. With the standard Cost Manager, costs have defined start and end 
dates for projects that have budgets, scope, and schedules. Cost is broken down by work in the 
various disciplines and is managed using CBS codes. 

In the Generic Cost Manager, cost is time-based, not work-based, allowing you to manage costs 
that do not have a finite timeline, such as facility maintenance and upgrading. You can plan for 
these expenses during a time period, such as a quarter or year. Each shell has its own cost 
manager. 

Unifier projects are similar to shells that use CBS cost codes. You can combine shells and shells 
that use the CBS cost codes together. You can also create a hierarchy of shells that consists of 
shells that use the Generic Cost Manager and those that use the standard Cost Manager (CBS 
cost codes). 

In the Generic Cost Manager, cost is time-based, not work-based. You would use the Generic 
Cost Manager to work with the costs that do not have a finite time-line, such as those associated 
with maintaining and upgrading the building or facility. You can plan for these expenses during a 
time frame (such as a quarter or a year). The Generic Cost Manager enables you to track the 
time and corresponding budget for your ongoing facilities work. Each shell has its own cost 
manager. The Generic Cost Manager does not include: 

 Earned value 

 Cash flow 

 Funding 

 General Spends SOV 

 Pay App SOV 

Shell Landing Page (Classic View) 

Once you create a shell, it is available for use. To access your shell landing page: 
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1) Click the shell tab to open it. 

2) Switch to User mode. 

3) From the left-hand Navigator, click your shell name (for example: ) on top. 

The top section of the landing page contains the Shell Dashboard. See Configuring a shell 
dashboard (My Dashboard) (on page 23) for details on the shell dashboard, and instructions 
on how to configure the dashboard. 

By default, the shell dashboard contains the following blocks: 

 Image 

 Items Requiring Your Attentions Details 

 Links 

The bottom section of the shell landing page displays a mini-log window of sub-shells that have 
been created under the currently selected shell. 

For example, if you select the sub-shell South Bay, and then the further sub-shell Mathilda 
Northwest, this landing page displays. 
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To view the shell details, as overlay. The details include: Shell Name, Shell Number, and the 
following tabs: 

General 

Currency 

Options 

Links 

Calendar 

To open the audit log, as overlay. 

Shell Landing Page (Standard View) 

Once you create a shell, it is available for use. To access your shell landing page:  

1) Click the shell tab to open it. 

2) Switch to User mode. 

3) From the left-hand Navigator, click your shell name (for example: ) on top. 

The top section of the landing page contains the Shell Dashboard. See Configuring a shell 
dashboard (My Dashboard) (on page 23) for details on the shell dashboard, and instructions 
on how to configure the dashboard. 

By default, the shell dashboard contains the following blocks: 

 Tasks

 Notifications

 Mail

 Image

 Details

 Links

The bottom section of the shell landing page displays a log of all sub-shells that have been 
created under the currently selected shell. For example, if you select the sub-shell South Bay, 
and then the further sub-shell Mathilda Northwest, this landing page displays. 

By default, the following two tabs are displayed. 

 Summary

 Workspaces

You can change the layout of the tabs, in My Dashboard or other custom dashboard. 

Example 

Block Length: 2 units 
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Block Height: 2 units 

The following explains the various informational blocks in the Summary tab:  

 Tasks

This block lists the total tasks belonging to the shell. When you click on Tasks you go to the 
Task log directly. You will be able to add this block in all tabs (in all dashboards) by using the 
data-source "Items Requiring Attention" in the Standard block. Also, you can remove the 
block from My Dashboard. 

 Notifications

This block lists the total notifications belonging to the shell. When you click on Notifications 
you go to the Notifications log directly. You will be able to add this block in all tabs (in all 
dashboards) by using the data-source "Items Requiring Attention" in the Standard block. 
Also, you can remove the block from My Dashboard. 

 Mails

This block lists the total mails belonging to the shell. When you click on Mails you go to the 
Inbox log directly. You will be able to add this block in all tabs (in all dashboards) by using 
the data-source "Items Requiring Attention" in the Standard block. Also, you can remove the 
block from My Dashboard. 

 Project Image

This block displays an image, if available; otherwise, the block will be blank. 

 Details

This block is displayed with either custom fields or default fields based on the configuration of 
the details block that is designed in uDesigner, shell manager. In the latest version of Unifier, 
the shell home landing page displays the custom fields; otherwise, the shell home landing 
page displays the default fields, only. 

You can edit the details block using the pen icon or through Edit dashboard option. This 
capability applies to block information, or to the fields that must be displayed in the block. 

 Links

If links have been added to the shell details, then those links are displayed in this block. 

 Sub-shell log

This block displays the sub-shells of parent shell, based on the view that you have selected. 
You can hide Workspaces in other dashboards.  

The user-created dashboards support all of the existing functionalities, except the sub-shell 
log. 

You cannot delete Workspaces tab in any Dashboard. 

You cannot hide the Workspaces tab in My Dashboard. As a result, you cannot deselect the 
Show checkbox for Workspaces. 

14. User will be able to hide Workspaces Tab in all user-defined Dashboards and will be able 
to un-check the 'Show' checkbox for Workspaces. 

Important Information

The Tasks, Notification, and Mails can be added or removed. Individual tiles cannot be 
added/removed. 
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The block will get displayed back, post removal, by navigating to Add Block > Standard and 
selecting Data Type as "Items Requiring Your Attention." When you save the Standard Block, 
the block will be added automatically to the dashboard. 

The following explains the various informational blocks in the Workspaces tab: 

The Workspaces tab is available when geo-code server details are configured in Unifier, only. 

 If there are no geo-location present in the sub-shells, Unifier displays a map without location 
markers. 

 If there is a geo-location present in the sub-shells, Unifier displays a map with location 
markers. 

When you hover the mouse over the location markers on the map, you can see the details for 
the location marker based on available information. 

When you right-click on the location marker, you can open the shell (for that location) in a new 
tab, in Unifier. 

The My Dashboard sub-menu (the three dots) enables you to: 

 Access additional dashboards for the shell, if available. 

 Edit Dashboard 

To open the editing mode of the current dashboard. 

 Details 

To view the shell details, as overlay. The details include: Shell Name, Shell Number, and the 
following tabs: 

 General 

 Currency 

 Options 

 Links 

 Calendar 

 Integration 

 Audit Log 

To open the audit log, as overlay. 

The Workspaces tab has the following toolbar options: 

 View 

For example, Buildings, Cities, Shells, Projects, Regions. 

 Actions 

 Get Activity Sheet Data 

All Shells 

Selected Shells 

Filtered Shells 

History 

 Send Activity Sheet Data 

All Shells 
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Selected Shells 

Filtered Shells 

History 

 Search 

 Find on page 

 Expand All Groups 

The columns the Workspaces tab sub-shell log are not hard-coded. The fields defined in Shell 
Detail form (in uDesigner) are added as columns in the Sub-shell log. 

 Name 

 Shell Number 

 Shell Name 

 Description 

 Status 

 Administrator 

 Location 

 User-Defined Text 

The right-hand pane displays the map that shows the regions. 

Shell Navigation 

You can navigate between current Shell, sub-shells, and instances through the use of: 

 Tabs to move from one single instance Shell to another 

 The Landing Page mini-log at the bottom of the landing page 

Note: You can search for instances within a Shell by using the Landing 
Page Log Find functionality. 

 The View drop-down menu to filter shells by types, which are displayed in the Shell log, 
based on the shells defined in the hierarchy 

 Breadcrumbs to navigate up and down the shell hierarchy 

 A geocoded map, which allows you to click on map pins to navigate to associated shells 

 If a Shell does not have sub-shells, then in the Workspaces tab you will see the location 
markers (pins) for the Shell.  

 If a Shell has sub-shells, then in the Workspaces tab you will see the location markers 
(pins) for the sub-shells, only. 

Shell Dashboard 

About Shell Dashboard 

From the Shell Dashboard, you can: 

 Use the Drill-down functionality to access the Shell data 
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 Use filters on the Shell Dashboard so that all blocks in a particular dashboard can be filtered 
based on the same parameter 

 Print the entire dashboard, or individual dashboard blocks 

 Minimize and maximize the entire dashboard, or a block 

 Use a free-form dashboard layout that gives you the ability to drag and drop dashboard 
blocks as an alternative to using pre-defined layout 

The following explains the following topics related to Shell Dashboard: 

 Using Custom Shell Dashboard 

 Minimizing Shell Dashboard 

 Expanding Shell Dashboard 

 Printing Shell Dashboard 

 Navigating Through Shell Block Drilldown 

 Setting Filters on Shell Dashboard 

 Using Drilldown 

 Scrolling Vertical Y-axis in Shell Dashboard Graph 

Using Custom Shell Dashboard 

You can use a custom Shell Dashboard in your Shell instead of the default configurable Shell 
Dashboard. To use a custom Shell Dashboard: 

1) Navigate to a shell. 

2) Choose Edit > Dashboard. 

3) Select Use Custom Dashboard. This selection defines the custom dashboard as your 
default dashboard; you will see this dashboard when you open this shell. 

4) Click Select and browse to select the SWF file for the custom shell dashboard. 

5) Click OK. 

Minimizing Shell Dashboard 

Click the minimization icon to minimize the Shell Dashboard. You can minimize the Shell 
Dashboard blocks individually. 

Expanding Shell Dashboard 

Click the expansion icon to expand the Shell Dashboard or to fill the width of the Shell 
Dashboard. You can expand the Shell Dashboard blocks individually. 

Printing Shell Dashboard 

Click the print icon to print a Shell Dashboard. You can print the Shell Dashboard blocks 
individually. 

Navigating Through Shell Block Drilldown 

Click the left-arrow icon to navigate up the Drilldown in a Shell Dashboard block. 
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Setting Filters on Shell Dashboard 

Click the Filters button in the upper left-corner of the Shell Dashboard. 

If there are filters defined, they will be listed, and enable you to filter the Shell Dashboard data 
by criteria defined in the Edit > Dashboard Filters window. 

To set filters on a Shell Dashboard block: 

1) Click the Filters button. The Filters window opens. 

2) Enter the filter criteria. 

3) Click OK. 

The data view in the block changes to reflect the filtering. 

4) You can turn off the filter by clicking the red X associated with the displayed filter criteria. 
The data view for the block returns to the default, unfiltered view. 

Using Drilldown 

You can click on activated elements in Shell Dashboard blocks to drill into layers of data 
contained in the Shell. 

Note: The drill-down functionality is supported for charts only. Drilldown 
is not available for grids or tables, and Drilldown stops when a grid or 
table is encountered. 

To drill-down into Shell Dashboard block data: 

1) Click a data representation in the data block. 

For example, you can drill down into the next configured level of data for a Shell called 
Terminal Expansion by double clicking on that section of the chart. 

2) View the next level of data. In this example, after you double click on Terminal Expansion, 
the next level of data displayed looks like this: 

3) You can return to the original data view by clicking the left arrow icon. 

Scrolling Vertical Y-axis in Shell Dashboard Graph 

If there are enough records represented, you can scroll up and down the vertical y-axis of a 
graph using a scroll bar. 
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Project Shell Dashboards 

Project shell dashboards display project data in an at-a-glance format. You can control the 
dashboard look and content and make it specific to the shell that you are working with. 

Shell dashboards cannot pull data from across shell hierarchies. For example, consider two 
anchor tabs, one called Capital Projects, and one called Facilities. The Capital Projects 
dashboard can display data from all levels of the Capital Projects hierarchy; however, it cannot 
display Facilities data because Facilities is a separate, independent hierarchy. 

Two types of dashboards are available in project shells: 

Administrative dashboard

These are designed by the shell administrator and pushed via templates. Administrators with 
dashboard Setup permission can create multiple shell dashboards for each project shell. 
Users can select administrative dashboards to view from the View Dashboard drop-down list 
on each shell. These dashboards are maintained at the shell level and are available to any 
user to view, provided the user has permissions. Users cannot edit an administrative 
dashboard. 

My Dashboard

Designed by an individual user, it is a personalized view that contains only the information 
the user wants to see. 

Note: In most cases, the Company Administrator will configure the shell 
dashboard for you. 

Each shell dashboard has at least one tab and can have up to five tabs. The default tab name is 
Summary, which you can change. The default shell dashboard layout contains these four blocks: 

 Image Displays the image your company administrator uploaded for the shell. 

 Items Requiring Your Attention: Contains items that are generally listed on the Unifier 
Home page, such as tasks and messages. 

 Details: Lists shell details, including shell number, shell name, administrator, and other 
details. 

 Links: List of links configured for the shell by your company administrator. 

On each tab, you can select a different layout to which you can add blocks of these types: 

 Standard: Use this selection to view project data from, for example, business process, 
manager, users, and active tasks 

 Portlet: Use this selection to view an external URL, such as a web cam, or a frequently 
visited web site 

 Drilldown: Use this selection to slice and dice project-shell data. See Add a drilldown block 
to my dashboard (on page 25) 

 Custom: Use this selection to view data from the current shell, subordinate shells, or both 
(cannot cross hierarchies) 
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Configuring a shell dashboard (My Dashboard) 

Project shell dashboards display project data in an at-a-glance format. You can control the 
dashboard look and content and make it specific to the shell that you are working with.  

All shells have a dashboard that the end user can configure if they have Setup permissions. The 
dashboard is the user’s personal dashboard, with their personally configured view of shell data. 
My Dashboard can be configured by end users in User Mode using the Edit Dashboard window, 
but is often configured for each user by the Administrator. Users can select this type of 
dashboard to view from the View Dashboard drop-down list on each shell. This dashboard is 
recommended if the user wants a personalized dashboard to view data that they specifically 
need to see regarding the shell.  

To configure a shell dashboard (My Dashboard) 

1) From the shell landing page, select Edit > Dashboard. The Edit Dashboard window displays.  

There are two sections to this window: Tab Setup and Source Details. Under Tab Setup, 
the default first tab already has a name and layout that you can modify. 

2) To change the tab, click the tab name. Change the tab name, and select a layout for the tab. 
You can experiment with layouts to see which one works with the information that you want 
to display.  

3) Select the Show checkbox to show the tab in the dashboard.  

Under Source Details, you can add standard or custom blocks. Double-click to select a 
default standard block and modify it as needed.  

To add a standard block: 

4) Click Add > Standard. You can add any number of blocks, but the dashboard displays the 
blocks based on the tab layout you select. See the first table below. 

5) Click OK to save your changes and exit the Edit Standard Block window.  

6) To add a custom block, click Add > Custom. See the second table below. 

7) Click OK to save your changes and exit the Edit Custom Block window.  

8) To add a portlet, click Add > Portlet. Enter the portlet name and the URL or IP address.  

9) This allows you to add content to your dashboard from a URL address. For example, you 
could use this portlet to specify a webcam site to monitor activities via a live camera. You 
can add as many portlets as needed. 

10) You can define a block that allows users to drill down into the displayed data. 

Note: You must add drilldown blocks if you want to use filtering on your 
dashboard blocks. 

11) After you define the drilldown, you can also add filters.  

12) To remove a block, click Remove. To reposition a block, click Move Up or Move Down.  

13) Click another tab name to modify the tabs and sources for that tab. Repeat these steps for 
each tab until you have configured the entire dashboard to meet your needs.  

14) Click Apply to save your configuration, and then click OK to close the window.  

Use the following table for Standard blocks. 
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In this field Do this 

Source Name Enter a source name. 

Data Type  Select a data type. The data types are: 

 Business Process: general business process information 

 Document Management: total documents 

 Active Task Information: Active task metrics 

 Users: Metrics by Company 

 Image: shell image 

 Items Requiring Your Attention: items such as tasks and 
messages 

 Details: Shell details, such as shell number and name 

 Links: Links configured for the shell 

 <specific business processes> : details on selected business 
processes, such as record status and tasks 

Report On Select what to report on.  

Block Title Add a title for this block. 

Display Type Select the chart type. 

Show Result Choose Actual Value or Percent of Total. 

Show Total Select this checkbox to display the total.  

Decimal Places Select the number of decimal places. 

Use 1000 
Separator (,) 

Select this checkbox to use the comma as a 1000 separator. 

Negative Number 
Format 

Select the format for negative numbers. 

Currency Format Choose None, Shell Currency, or Base Currency. 

Use the following table for Custom blocks. 

This item Does this 

Data Cube Select the shell data cube definition to use. Data cubes are 
queries that can be defined and reused to create charts on 
your dashboard. Your company administrator defines the 
data cubes. 

Show data from Enables you to select the shells to use as data sources. You 
can choose: 

 Current Shell Only 

 Subshells Only 

 Current Shell and Sub-shells 

Block Title Add a title for this block. 
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Display Type Select the chart type. 

Source Grouped By Select how the source is grouped. 

Output Type Choose either Record Count or Summary Value. 

Report On Select what to report on. 

Show Result Choose Actual Value or Percent of Total. 

Show Total Select this checkbox to display the total. 

Decimal Places Select the number of decimal places. 

Use 1000 Separator (,) Select this checkbox to use the comma as a 1000 separator. 

Negative Number 
Format 

Select the format for negative numbers. 

Currency Format Choose None, Shell Currency, or Base Currency. 

Add a drilldown block to my dashboard 

You can add a drilldown block that allows you to access greater levels of data detail. 

For example, if a dashboard block shows a pie chart with data for two projects, called Parking 
Extension and Terminal Expansion, and you can double-click on Terminal Expansion to expose 
the vendors on that project 
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To continue the example, when you double-click on Terminal Expansion the to access the 
vendor information, and the amount associated with the vendors Acme Equipment, Pacific 
Building Interiors, and L. Loring & Company: 

Note: If you want to use filters on your dashboard blocks, you must first 
define a drilldown block. 

To add a drilldown block to your shell dashboard 

1) On the Edit Dashboard window, click Add > Drilldown. The Edit Drilldown Block window 
opens. Drilldown functionality is supported for charts only, and is not available for grids or 
tables. Drilldown will stop when a grid or table is encountered. See the first table below. 

2) Click Add to add Drilldown Details. The Edit Drilldown Details window opens. See the 
second table below. 

3) When complete, click OK, and click OK to exit the Edit Dashboard window. 

This item Does this 

Data Cube 
Select the data cube definition to use. Data cubes are queries that 
can be defined and reused to create charts on your dashboard. 
Your company administrator defines the data cubes. 

Block Title Add a title for this block. 

Block Filter 
Elements 

Group By elements from the data cube. This determines which 
columns from the data cube definition will be used to group data 
for filtering. 

In this field: Do this: 

Title Enter a title for the drilldown. 
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Show Data From Select the shells to use as data sources. 

Display Type Select the type of display, for example, a bar chart. 

Source Grouped 
By 

Select the columns from the data cube definition that will be used 
to group data. 

Output Type Select Record Count or Summary Value. 

Report On Select the columns from the data cube to be defined as Summary.

Summary Type Select the summary type. 

Show Result Select the type of result, for example, Actual Value. 

Show Total Select to show the totals for the data. 

Decimal Places Select the number of decimal places. 

Use 1000 
Separator (,) 

Select to use a comma (,) as a separator. 

Negative Number 
Format 

Specify the format for negative numbers. 

Currency Format Select the currency format. 

Add filtering to the drilldown block 

You can add filtering on a drilldown block in your shell dashboard. You must first define the filter 
at the block level, and then specify that it appear on the dashboard for use. 

To add filtering on a drilldown block in your shell dashboard 

1) To define the drilldown at the block level, click Select next to Block Filter Elements on the 
Edit Drilldown Block window. 

2) Select the data elements from the data cube that you want to use as filters. 

3) Click OK to exit the Edit Drilldown Block window. 

4) On the Edit Dashboard window, click the Filters button to add filters at the dashboard level. 
The Configure Filters window opens. 

5) Click Add. The Add Filter window opens. 

6) Enter the filter name. 

7) Select the filter you want to use on the dashboard block. 

8) Click OK, and then click OK to exit the Configure Filters window. 

Optimizing Shell Dashboard Performance 

You can sometimes improve shell dashboard display performance by following a few guidelines. 
Shell Dashboard performance can depend on how many dashboard blocks are defined and the 
volume of data retrieved by the dashboard query. 

Here are some tips to improve shell dashboard performance: 
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 Reduce the number of dashboard blocks, if possible. 

 Define conditions for SQL filtering to return less data. 

 Do not check Show Total when you configure dashboard blocks. 

 Do not select Percent for Show Result. 

View dashboards 

Users with Configure User Dashboard permissions can configure and maintain a shell 
dashboard. This user-configured dashboard is listed as My Dashboard in the View Dashboard 
drop-down list. This menu can also list shell dashboards that were configured by the 
Administrator. 

For example, the Administrator can create separate shell instance dashboards to serve various 
business groups that are using shells in a single instance. For example, the Administrator can 
create these types of shell instance dashboards for a shell instance called Building 100: 

This dashboard To serve this business group 

Operations Dashboard Operations and Management groups 

Technical Services Dashboard Technical Support and Services group 

Lease Management Dashboard 
Vice President of Leasing Services and his 
reports 

With permissions, you can view the dashboards provided by the Administrator, but you cannot 
modify them. 

To view dashboards 

1) Navigate to a shell. 

2) Select a dashboard from the View Dashboard drop-down list. Any dashboard that you have 
configured for yourself is called My Dashboard. 

3) You can select dashboard in the View Dashboard drop-down list to which you have View
permission. The last dashboard that you view will display the next time you sign in to Unifier. 

Expand the Shell Log on the Landing Page 

You can expand the shell log (the bottom area of the shell landing page) by clicking the 
rectangle next to the View drop-down list. 

About Shell Statuses 

Your shell can have one of four statuses. 

 Active: A live, in-progress shell. 
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 On-Hold: The initial shell status. On-hold shells appear on the shells log. Shell 
administration functionality is available to shell administrators for setup and maintenance for 
users with permissions to perform that function. Users cannot create records in a shell that is 
On-Hold. If a user attempts to access a shell that is On-Hold, the system displays an alert 
message stating that the shell is On-Hold. 

 View-Only: View-Only shells can be viewed, printed, exported, and included in reports. You 
cannot modify any data in View-Only shells. This allows you to view past shells without 
allowing changes to these shells. If a shell in a shell hierarchy changes to View-Only, you 
can still navigate up and down the shell hierarchy, and can create sub-shells in the hierarchy 
under the View-Only shell. 

 Inactive: Used to suspend shell usage. Inactive shells are visible to Administrators, but not 
to end users. Only System and Shell Administrators (users with Modify Status rights) can 
reactivate the project. 

Note: If automatic status update is enabled on a shell, the status of the 
shell can change from Active to an inactive status (On-Hold, View-Only, 
Inactive). The change of status is set up by the Administrator, and is 
based on defined triggering conditions. For example, if a shell is close to 
exceeding its funding, it might make sense to put it On-Hold while 
funding matters are discussed. Your shell administrator must manually 
change the status back to Active when you are ready to restart the 
project. 

The Shell Administrator will receive email notification when the status of a shell changes. The 
change of shell status could occur due to a manual change, bulk update, through Web Services 
or a CSV file, or through automatic update. 

Working with Shells 

A shell allows users to collaborate on and coordinate the execution of a project. 

Note: User access and permission levels for all functions are controlled 
by the company administrator. Contact your company administrator if 
you have questions regarding access. 

Open a Shell 

Open a shell to access the shell functions. 

To access shells 

From your user home page, click a shell tab. 

When you click a shell tab, the shell landing page displays. From the shell log, you can access 
the various sub-shells listed. 
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To open a shell 

Select a shell from the shell log and click Open. When you open the shell, the Navigator 
expands, providing access to shell-level features and business processes. 

To find a shell 

Since shell hierarchies can be extensive, Unifier provides a Find feature to help you locate a 
specific shell. 

1) Click the anchor shell tab that contains the shell you want to locate. 

The shell dashboard appears, and a "mini log" of sub-shells appears at the bottom of the 
window. 

2) From the View drop-down list on the mini log, select the sub-shell you want to search. 

3) Click the Find button. 

To accommodate the Find operation, Unifier collapses the dashboard to show only the mini 
log, and displays a Find window. 

On the Find window, you can search for shells using a geocode search or you can search for 
shells using search operators on shell information. Operators such as "contains" or "is not 
empty" can help you narrow the search for the shell. 

 To search using a geocode, enter an address, latitude, longitude, or radius 

 To search on shell information using operators: 

a. Choose the operator you want to use on the field, such as "equals," "does not contain," or 
"is empty." 

b. Enter the value the field should contain. 

4) Click Search (or press Enter). Unifier displays all the shells that meet the search criteria you 
entered. 

If you choose to, you can cancel the find operation by clicking [Cancel Filter] or the x icon in 
the upper-right corner of the window. Unifier will restore the mini log to its unfiltered state. 

5) When you have finished using the Find feature, click the Restore button to return the 
dashboard to normal view. 

Auto-Create Projects or Shells 

Unifier provides a type of business process that will create new shells (and standard Projects) 
from the upper form of the BP or from BP line items. The data necessary to create 
shells/projects is provided by this BP. In addition to creating a new shell, this type of business 
process can also be designed so that you can choose the managers and employees who should 
be automatically assigned to the shell when it is created. 
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Note: In order for auto-creation to occur correctly, be sure you 
understand the hierarchy of the shells in your company. This is important 
for placing the shell in the correct position in the hierarchy as well as 
choosing the correct template with which to build it. If the template is not 
the correct one, the creation will not succeed. 

You can use the Project/Shell Creation business process to create shells and projects from the 
project or shell templates set up for this purpose in Unifier. Templates provide shells or projects 
with the name, number, location, and status for each new project or shell, as well as any 
included images and phase definitions. If the template includes links, the new shell landing page 
will display these links. If designed and configured to do so, the template will automatically 
assign a manager and employees to the shell/project. 

Working with Planning Items 

If a Planning Item Picker has been included on this business process, you can link new 
projects/shells with planning items. Instead of linking a planning item to a project in the Planning 
Manager, this BP will automatically create the link when the project/shell is created, and data will 
begin to roll up to the Planning Sheet from the business processes in this project. 

To auto-create a single shell or project 

Auto-creation of a single shell or a project, only requires that you complete an upper form. 

1) Navigate to the level (such as Company Workspace or a shell) where the auto-creation 
business process resides. 

2) In the Navigator, select the business process then on the right pane, click New. The 
business process opens. 

3) Enter a name and number for the new shell and select an administrator for the shell. 

4) Specify where the shell should reside in the hierarchy by choosing a shell location as follows: 

a. Click the Select button. A shell picker opens, showing the tabs of all the current anchor 
shells. 

b. On the shell picker, click the anchor shell under which the new shell should reside. If the 
new shell should reside under a sub-shell, double-click the sub-shell. 

The sub-shell may contain other sub-shells. You can navigate to them by clicking the View
drop-down (located in right corner) and selecting the sub-shell from the list. 

5) Specify the template that should be used to create the shell as follows: 

a. Click the Select button. The Shell Template picker opens, showing a list of the templates 
that have been designed for the shell type this BP will create. 

b. Select the template and click the Select button. The name of the template appears in the 
field on the form. 

6) Specify the shell status, such as Active or On-Hold. 

When the shell is created, this is the status it will be assigned. 

7) Specify the BP status. 

When this status reaches this BP’s designated "terminal" status, it will automatically create 
the new shell or project and assign it the status you specified in step 6. 
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Note: If you do not specify a status, Unifier will assign a status of 
Inactive to the shell and you will have to manually change the status to 
make the shell active. 

8) Complete any other fields that have been included on the form. 

9) Click Finish Editing. 

When the business process reaches its terminal status, it will create a new shell/project 
using the template you specified on the BP form, and the new shell/project should appear in 
the hierarchy in its appropriate place. 

To auto-create multiple shells or projects 

To auto-create multiple shells or projects, you need to fill out an upper form, and create line 
items for each shell/project you want to create. Unifier will use each line item to create a 
separate shell/project. 

1) Navigate to the level (such as Company Workspace or a shell) where the auto-creation 
business process resides. 

2) In the Navigator, select the business process and on the right pane, click New. The business 
process opens. 

3) Complete the upper form fields, including the status of the business process. 

4) Click the Add button at the bottom of the window and choose Detail Line Item. A Line Item 
window opens. 

5) Enter a name, number, and description for the new shell and select an administrator for the 
shell. 

6) Specify where the shell should reside in the hierarchy by choosing a shell location as follows: 

a. Click the Select button. A shell picker opens, showing the tabs of all the current anchor 
shells. For example: 

b. On the shell picker, click the anchor shell under which the new shell should reside. If the 
new shell should reside under a sub-shell, double-click the sub-shell. 

The sub-shell may contain other sub-shells. You can navigate to them by clicking the View
button and selecting the sub-shell from the list. 

7) Specify the template that should be used to create the shell as follows: 

a. Click the Select button. The Shell Template picker opens, showing a list of the templates 
that have been designed for the shell type this BP will create. 

b. Select the template and click the Select button. The name of the template appears in the 
field on the form. 

8) Specify the shell status, such as Active or On-Hold. 

When the shell is created, this is the status it will be assigned. 

Note: If you give the shell a status of Inactive, child shells cannot be 
created. 

9) Specify the line item status. 
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This is the status at which the line item should be to create a new shell/project. When the line 
item reaches the status you specify here, Unifier will automatically create the new shell or 
project and assign it the status you specified in step 8. 

10) Complete any other fields that have been included on the form. 

11) Click Finish Editing. 

When the business process reaches its terminal status, and the line item status reaches the 
status you specified in step 9, Unifier will create a new shell/project using the template you 
specified, and the new shell/project should appear in the hierarchy in its appropriate place. 

Working with Shell Features 

The Navigator displays the shell-related features that you have permission to access (Shell > 
User mode). Depending on the modules that your company has set up and your access 
permissions, the following shell functions that are typically available.  

Note: Company administrators can configure the Navigator to better suit 
business needs, such as creating nodes to store business process 
records. 

Function Description 

Alerts You can access the following information regarding the alerts: 

 Alert Title 

 Current Value 

 Trigger Value 

 Status 

You can create customized alerts for a condition or event. 

Tasks Not available for View-Only and Inactive shells.  

Lists: 

 Current business process tasks that have been assigned to you. 

 Business process tasks that you have been copied on. 

You can use the View option to display tasks: 

 Received in last 7 days 

 Received in last 30 days 

 Group by Business Process 

 Group by Origin 

 Late Tasks 

You can use the View option to create new view (Create New View) and 
manage the existing views (Manage Views). 
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Drafts Not available for View-Only and Inactive shells.  

Lists: 

 Draft copies that you have saved. 

You can access the following information regarding the drafts: 

 Attachments 

 Business Process 

 Record Number 

 Title 

 Last Saved 

 Discussion (Classic View only) 

The right-hand pane of the Drafts log has the following tabs, which provide 
additional information about a selected draft item: 

 Record Details 

 Workflow Progress 

 Attachments 

Mailbox Has the following sub-nodes:  

 Drafts 

 Inbox 

 Notifications (Notifications are available for View-Only shells, but you 
cannot add general comments.) 

 Sent Items 

 Project Mailbox 

 Inbox 

 Custom folder 

 Deleted Items 

See Additional Information about Using the Shell Mailbox (on page 42) 
for details. 

Mailbox has two functions:  

1) An internal email feature that allows Unifier shell team members to 
communicate with each other and maintain a record of the communications. 
For shells with View-Only status, Mailbox is available for viewing, but you 
cannot send, edit or delete messages. 

2) The repository that collects external emails related to the shell. These 
emails can come from shell users or from external users who do not use 
Unifier. From the Mailbox, users can forward the emails to appropriate 
members, flag them for review, and reply to them. In addition, these 
external emails can be linked to business process records.

Informati
on

Lists the shell directory (Directory) and general BP information. 

Gates Displays phase and gates information and enables manual or automatic 
advancement of phases. 
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Configur
able 
Modules

Lists the configurable modules that have been created to work with your 
shells. 

Cost 
Manager

Lists shell-level cost manager functions such as: 

 Cash Flow 

 Cost Sheet 

 Earned Value 

 Funding 

 Schedule of Values 

Docume
nt 
Manager

Allows for collaboration, revision control, or markups of: 

 Documents: Shell documents 

 Unpublished Documents 

Resourc
e 
Manager

Allows access to: 

 Resource Dashboard 

 Resources 

 Resource Sheets 

Schedul
e 
Manager

Allows access to: 

 Schedule Sheets 

Logs Allows access to the shell business processes. 

Reports Allows access to user-defined reports. 

Auditing Shell Changes 

The shell audit log lists the actions that have been taken on a specific shell. The Audit log 
captures changes that have been made to the fields on the shell’s attribute form. 

To view an Audit log 

From the View menu of the shell record, click Audit Log. The Audit Log window opens, listing 
each event that was taken on the shell’s attribute form. The date and time stamp of each event 
reflect users’ current time zone as set in their User Preferences. 

To view audit details 

From the Audit Log window, double-click a listed event to view the audit record detail, which 
details the action taken. The details also include the user’s current time zone for reference. 

To print a business process Audit log 

1) On the Audit Log window, click the Print button. A PDF file is created. 

2) Do one of the following: 
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 Click Open to open the file in Adobe Acrobat Reader. From the Reader window, you can 
view, save, or print the file. 

 Click Save. In the Save As window, navigate to the location in which you want to save 
the PDF file. Open the file in Adobe Acrobat Reader and choose File > Print to print. 

Add an Image 

If an Image picker is available to your shell, forms display the image name and a box to hold the 
uploaded image. An Image picker can be added to all forms, except for those in the Cost 
Manager, Generic Cost Manager, Schedule Manager, and Document Manager. 

You can change the image by replacing it with another uploaded image. Images display as 
HTML or PDF formats in printed forms as well as in print preview. 

Note: The image name is based on the data element name provided in 
uDesigner. 

To add an image 

1) Click Upload Images in the toolbar at the top of the form. 

2) Browse for the image to upload and click OK. 

3) Click OK. 

Note: Unifier displays the image online, but it is not available for printing. 
Also, images do not appear in UDRs or email notifications. 

For information about translating Email Notifications refer to Unifier General User Guide for 
details. 

Managing Shell Alerts 

You can create customized alerts for a specific condition or event. For example, you could set 
up an alert that sends you an email letting if a fund amount on the funding sheet has reached a 
certain level. 

Alerts are created by creating an Alert-type user-defined report. 

To create an alert 

1) Create an Alert report in user-defined reports. 

2) Open a shell and click Alerts in the Navigator. The Alerts log opens. 

3) Click New. The Alert window opens. 

4) Complete the window as described in the table below. 

5) Click OK to close the Alert window. 

In this field Do this 

Report Name 
Click the Select button. The list of user-defined alert reports for 
the shell opens. Select a report from the list and click the Open
button.You can also click the Find button and enter search 
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criteria to locate a specific report. 

Note: Reports that are already used to create an alert are shown 
with a checkmark. You can create more than one alert for each 
report. 

Description Populated automatically with the report description, if one exists.

Alert Title 
Appears as the title of the alert in the log and on the alert sent. 
By default, the field shows the report name, but you can change 
the name. 

Frequency 

How often you want the alert to be sent when the trigger 
condition is met: 

Never: Alerts are not sent. 

Hourly: Sent every hour, at about 20 minutes past the hour. 

Daily: Daily at about 2:20 a.m. 

Weekly: Sent on Mondays at about 2:20 a.m. 

Monthly: Sent on the first day of the month, about 2:20 a.m. 

Times might vary. The times are based on the Unifier server 
used. Unifier servers operate on Pacific Standard Time. 

Note: If you choose a frequency other than never, you must 
specify a method and message. 

Method 
Select one or both of the methods to be notified of the alert. For 
email, the address in your user profile is used). 

Message 
Type a message that you want included in the alert. Remember 
that this is an alert that only you see, so enter as much or as 
little detail as you need. 

To edit alerts 

1) Open a shell and click Alerts in the Navigator. The Alerts log opens. 

2) Select an alert and click Open. The Alert window opens. 

3) Make changes to the alert as needed and click OK. 

To delete an alert 

Open a shell and click Alerts in the Navigator. The Alerts log opens. Select an alert and click 
Delete. 

Working with Mailbox (Shells) 

The shell Mailbox is an internal Unifier email feature that allows Unifier shell team members to 
communicate with each other and maintain a record of the communications. The shell Mailbox
interface is similar to common email programs such as Microsoft Outlook. The shell Mailbox
supports file attachments and emails can be sent between shell team members and to external 
email addresses.  
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Note: The external email cannot be sent directly to the shell Mailbox. 

A copy of every mailbox communication is saved in a central folder controlled by the shell 
administrator. These communications become part of the shell record. The shell or company 
administrators must grant users permission to access the shell Mailbox folder. 

Depending on permissions, users can view all messages or only those in which they participated 
(sent or received). Permission can also be granted to deleted items in the shell Mailbox folder. 
Once deleted, the communications are not recoverable.  

Note: Users who sent or received the deleted message may still retain 
copies of these messages in their own Inbox or Sent folder. 

For additional information see Home Page (Mailbox). 

Access Mailbox 

The shell Mailbox feature is shell-specific, and the full functionality is accessed at the shell level. 
A cross-shell listing of your Inbox can also be accessed in the Mailbox node on the Home
page. See Home Page (Mailbox) for additional information.  

To access Mailbox from a shell 

1) Open a shell (User mode) 

2) In the Navigator, click Mailbox. The Mailbox folders expand. 

 Drafts: Displays Mailbox messages that you have drafted but not yet sent. 

 Inbox: Displays messages sent to you. 

 Notifications: Displays your notifications. 

 Sent Items: Displays messages that you have sent. 

 Project Mailbox: Stores copies of all Mailbox messages sent between shell team 
members. Access to this folder must be granted through permission settings. 

The Project Mailbox supports additional email addresses such that emails can be 
directly sent to those email addresses. The additional email addresses are available as 
additional folders along with the default project inbox. You can move emails between the 
inbox and the additional folders. 

 Deleted Items: Displays items that you have deleted from one of the other folders. 

To view all your Mailbox messages across shells 

1) Go to the Home page. See Home Page (Mailbox) for additional information. 

2) In the left Navigator, click Mailbox. All messages residing in all shell Mailbox Inbox and Sent 
folders are listed. 

3) To open a listed message, select it from the list and click Open. 

To search for a specific Mailbox message across shells 

1) Click the Home page. See Home Page (Mailbox) for additional information. 
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2) In the left Navigator, click Mailbox. All messages residing in all shell Mailbox Inbox and Sent 
folders are listed. 

3) Click the Find button. 

4) Enter search criteria in the Subject Containing or Message Containing fields in the upper 
portion of the log window. 

5) Click Search. The log lists the messages meeting the search criteria entered. 

Send and Receive Mailbox Messages 

Mailbox functionality is similar to common email programs. You can attach files, format text, flag 
the message, compose and save a draft of your response without sending it, and preview your 
message in a browser. You can correspond with your Unifier shell team members through uMail, 
and use Mailbox to send messages to external email addresses. External email users cannot 
send email directly to Mailbox. 

To send a Mailbox message 

1) Access Mailbox and select any Mailbox folder. 

2) Click New. A message window opens. 

3) Choose the recipients of the Mailbox message by doing any of the following: 

 Click To. The User/Group picker opens displaying shell users. Select the recipients from 
the Select Users list and click Add. Click OK to close the picker. 

 To send a copy to another recipient, click Cc, and then choose the recipients from the 
User/Group picker. 

 To send a copy to an external email address, enter the address in the External Cc field. 
Separate multiple addresses with a semicolon (;). The recipient sees Unifier Notification 
in the From field and cannot reply directly. 

 To send a blind copy (bcc), click the View menu and select Bcc Fields. The Bcc button 
and External Bcc field become available on the Mailbox message window. 

4) Type the subject of the message in the Subject field. 

5) Type the body of the message in the text field. 

Note: To attach files, format the text, flag a message for follow up, 
compose and save a draft of your message without sending it, or 
preview your message in a browser, see the following procedures. 

6) Click Send to send the message. 

To view or respond to a Mailbox message 

1) Double-click a message to view it. The message opens. 

2) To respond to the message, do one of the following: 

 To send a reply to the sender, click Reply. 

 To send a reply to the sender and other recipients of the original message, click Reply to 
All. 

 To forward the message to another recipient, click Forward. File attachments remain 
with forwarded messages. 

3) Type your response and click Send. 
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To attach files to a Mailbox message 

1) Open the Mailbox message. 

2) Click Attach and choose one of the following: 

 To attach the file from your local system, select My Computer. The procedure is the 
same as uploading files to the Document Manager. 

 To attach documents from the Document Manager, select Primavera Unifier Folder. 
The window opens, displaying the shell documents files and folders. Select the files and 
folders to attach and click OK. 

Note: When attaching a folder, the contents of the folder are attached in 
a flat list. You cannot attach documents with duplicate file names. 

3) Click OK to add the file, and the click OK to close the General Comments window. 

You can also send a copy of a completed BP form directly while working in the BP form. Unifier 
automatically creates a PDF copy to send via Mailbox. 

To flag a Mailbox message for follow-up 

1) Open an existing message, or create a new message. 

If you want to flag a message that you are replying to or forwarding, then open the message, 
and click Reply, Reply All or Forward. 

2) Click the Flag for Follow-Up button. The Flag for Follow-Up window opens. 

3) In the Flag to field, choose an action, such as "call," or "for your information." 

4) Click OK. The flag text appears at the top of the message. A red flag symbol will also display 
next to the message in the log. (You may need to refresh the log to see the flag.) 

5) If this is an existing message that you are flagging for yourself, you can simply close the 
message. If you are sending the message to someone else, add the recipients and send the 
message. 

To remove a Mailbox flag 

Click the Flag for Follow up button, and then click Clear Flag. 

To format Mailbox text 

1) Open the Mailbox message. 

2) Select the text that you want to format in the body of the message. 

3) On the Formatting toolbar, choose the formatting to apply to the text. 

To spell check Mailbox message text 

1) When you are finished composing a Mailbox message, click the Spelling button on the 
toolbar of the message. The body text of the message is checked. 

2) Make spelling corrections as necessary and click OK. 

To print a Mailbox message 

1) Open the Mailbox message. 

2) Click the Print button. 
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To print several Mailbox messages from the Mailbox log 

1) Navigate to a Mailbox log. 

2) Select several Mailbox records that you want to print. 

3) Click the Print button. 

To search for a Mailbox message 

1) In the Navigator, click a Mailbox folder. 

2) From the toolbar, click the Find button. The Find box expands above the log. 

3) Do any of the following: 

 To search by the recipient (To field), click the Select button and choose the user from the 
User/Group picker. 

 To search by subject, enter a word or phrase in the Subject Containing field. You can 
use partial entries. 

 To search by message content, enter a word or phrase in Message Containing. 

 Further refine the search by choosing Read or Unread. 

4) Click Search. The messages meeting your search criteria are listed in the log. 

To delete Mailbox messages 

1) Do one of the following: 

 From a Mailbox log, select the message and click Delete. 

 From within a Mailbox message, click Delete on the toolbar. 

The message is moved to the shell Deleted Items folder. 

2) To permanently delete a message, select it from the Deleted Items folder and click Delete. 
Click Yes to confirm. 

Link Mailbox Messages to Business Process Records 

You can link shell mailbox messages directly to BP records using the Linked Mailbox link at the 
bottom of the BP form. 

Note: This option is available only in BPs that have been set up to 
accommodate linked Mailbox messages. Attaching messages or viewing 
attachments depends on your Mailbox permissions. 

To view a list of BP records to which a message is linked 

1) Open the message. 

2) If the message is linked to a BP record, the upper portion of the message displays the 
following: 

This message and any future replies are linked to records. Show list

3) Click the Show list link to view the list of BP records to which the message is linked. 
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Additional Information about Using the Shell Mailbox 

External emails are important communications that need to be included in shells. Such emails 
can come from shell members or from external users who do not use Unifier.  

Note: To use any of the mailbox features, you must have permissions. 

These email communications (and any attachments) are collected in a central repository for the 
shell, called the Inbox  (Mailbox > Project Mailbox > Inbox ) so that shell users can use them 
in managing and documenting the shell. Once such emails reside in the Inbox, the shell users 
can view them, forward them to appropriate members, flag them for review, and reply to them. In 
addition, the shell users can link these emails to business process records. 

Note: The external emails that have been blind carbon-copied (Bcc’d) 
are not collected by the Inbox. 

Creating additional folders 

1) Go to your shell/project (User mode). 

2) Click Mailbox to expand. 

3) Click Project Mailbox to expand. 

4) Click Inbox to open the Inbox log. 

If you have the View permission for Inbox sub-node, then you can view all folders under the 
Inbox sub-node. 

5) On the toolbar, click the folder icon to open the Folders window. 

You can see the folder icon only if you have the Create/Manager Folders permission. 

6) Click the plus icon to open a new row. 

7) Under the Name column, double-click the empty cell and enter a name for the new folder. 

 This field cannot be empty. 

 The maximum character length is 250. 

 You cannot use a name that already exists. 

8) Under the Email Address Code column, double-click the empty cell and enter a code. 

 This field cannot be empty. 

 The maximum character length is 120. 

 You cannot use a code that already exists. 

9) Click OK. 

Your newly created folder appears in the existing list of folders below the Inbox node. The 
positioning of the folders below the Inbox node is according to the ordering of rows in Folders
window. You can drag and drop rows in the Folders window in order to reorder the folder 
position in the navigator, on the left.  

Note: You can reorder more than one folder at the same time. 

In addition, you can double-click into any cell of the grid of an existing folder, in the Folders
window, and edit the folder properties (Name, Email Address Code). 
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The email address is calculated by the system according to the Project Email Pattern that is 
defined in Unifier Configurator. As a result: 

 When the Project Email Pattern, in the Unifier Configurator, is configured to be the prefix, 
the email address of the folder will be: <Email Address Code for the folder>-<project email 
id>. For example, if the Email Address Code of a folder is "construction," and the project 
email id is"bostonGenHospital-slc05kuz@internal-mail.oracle.com," then the folder email 
address will be "construction-bostonGenHospital-slc05kuz@internal-mail.oracle.com." 

 When the Project Email Pattern is configured to be the suffix, the email address of the 
folder will be such that the Email Address Code gets appended to the very end of the 
project email id. For example, if the Email Address Code of a folder is "construction," and 
the project email id is "slc05kuz+bostonGenHospital@internal-mail.oracle.com," the folder 
email address will be 
"slc05kuz+bostonGenHospital+construction@internal-mail.oracle.com." 

When a user sends an email to the email address of a folder, that email automatically lands 
inside the correct folder. Additionally, if the user specifies an incorrect value of the Email 
Address Code, and the rest of the project/shell email address is correct, then that email 
automatically shows up in the Inbox sub-node under the Project Mailbox parent sub-node. 

The toolbar options for the new folder (below the Email Address) is the same as the toolbar 
options for the Inbox sub-node. The actions Move and Folder are visible based on permissions. 

The options View, Edit View, Refresh, Search and Find on Page are the same as in Inbox
sub-node. 

The log layout listing the emails for a new folder is the same as for Inbox sub-node. Similar to 
Inbox sub-node, the user has the ability to move one or more emails from one folder to another 
using the right-click option > Move or using the Move option. 

By default, Inbox is available under Project Mailbox (Project/Shell > User mode > Mailbox > 
Project Mailbox > Inbox). You have ability to select Inbox, move it to the "Available Modules 
and Business Processes" section and then move it back below any other parent node in the 
"Selected Modules and Business Processes" section. 

When you move Inbox to the right section, the parent node Project Mailbox will disappear. 

When you move Inbox from the right to the left section below a new parent node, then Unifier 
inserts the Project Mailbox node as the direct parent node of Inbox. For example, if the original 
hierarchy was Folder A > Project Mailbox > Inbox, and the user moves the Inbox to the right 
section, and then moves it back to the left section below Folder B, then Unifier displays the 
hierarchy as Folder B > Project Mailbox > Inbox. In other words, the Inbox always resides below 
the Project Mailbox. 

You can send an email to unifier Project/Shell users giving them information about the additional 
email address of a Project/Shell. The email is a system-generated message with the following 
elements: 

Header: Email Address(es) for <project/shell number> - <project/shell name> 

Subject: Email Address(es) for <project/shell number> - <project/shell name> 

Body (text): This email is to inform you that a Unifier Mailbox has been setup for <project/shell 
number in bold chars> - <project/shell name in bold chars> 
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You must use the following general format for the email address: <project/shell email id> 

If the Project/Shell contains additional folders, the following text between two forward slashes //: 

//To send messages, including file attachments to specific folders, use 
the following email address(es):

1. <Folder 1 name>: <Folder 1 email address>

2. <Folder 2 name>: <Folder 2 email address>

3. <Folder 3 name>: <Folder 3 email address>

... <and so on>

//

Note: If there are no additional folders, this text must not be contained in 
the email body. 

The email is a system-generated message. 

All emails received, or existing emails in the Project Mailbox, are in the Inbox node below the 
Project Mailbox parent sub-node. 

To open the Shell Mailbox 

1) Open your shell. 

2) In the Navigator, click to expand the Mailbox node (Project Mailbox > Inbox). The right 
pane displays a log of the contents of the Inbox. 

To open an email 

On the Inbox log, double-click the email. Unifier opens the email. If there are attachments, the 
email will display an Attachments (n) link. To open an attachment, click the link and 
double-click the attachment on the list that appears. 

To flag an email for follow-up 

1) Open the email. 

2) Click the Flag for Follow-Up button. Unifier opens the Flag for Follow-Up window. 

3) In the Flag to field, choose the action you want for this email, such as "call," or "for your 
information." 

4) Click the Reply button to reply to the email, or click the Forward button to forward the email 
on to someone. 

When the recipient opens the message, the specific flag remark is shown across the top of 
the message. 

Note: To remove the flag, click the Flag for Follow up button, and then 
click Clear Flag.

To move an email from one folder to another folder 

1) Go to Inbox and click the email that you want to move. 

2) Click Actions drop-down list and click to select Move. This opens the Move window. 
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Alternatively, you can click the gear menu and select Move. 

3) In the Move window click to select the folder that you want to move the email into and click 
OK. 

The Move option is available only if more than one folder (including the Inbox) exists below the 
Project Mailbox parent sub-node, and you have the permission to view the Inbox. 

To create a folder 

1) Go to Inbox and click the folder icon. 

2) In the Folders window click the plus option to open a row on the grid. 

3) Double-click on each cell of this new row, under Name and Email Address Code columns, 
and enter the values. 

4) When finished, click OK. 

5) Ensure that you see the new folder under the Project Mailbox parent sub-node, below the 
Inbox sub-node. 

You can create new folders only if you have the permission to "Create/Manage" folders for the 
Project Mailbox. 

You can change the order of the folders by moving the rows in the Folders window. 

The order of folders arrangement below the Inbox node, in left-hand navigator, is according to 
the order of rows in the Folders window. The Inbox sub-node is always the top folder and directly 
below the Project Mailbox parent sub-node. 

To delete a folder 

1) Go to Inbox and click the folder icon. 

2) In the Folders window click to select the row of the folder that you want to delete. 

3) Click the trash-can icon and click OK. 

To reply to an email 

1) Open the email and click the Reply button. 

Unifier displays the addressee’s email address in the External To field. You can add 
additional external addresses in this field, separated by semi-colons (;). 

2) (Optional) To add email addresses to the Cc line, click the Cc button. The User/Group Picker 
opens. 

a. Select the user(s) you wish to add to the message and click Add. The names appear in 
the Selected Users area at the bottom of the window. 

b. Click OK. 

3) (Optional) To attach a file to the reply, click the Attach button and choose My Computer or 
Primavera Unifier Folder. 

a. In the window that opens, select the file you want to attach, or browse your computer’s 
directories to locate the file to attach. 

b. Click OK. Unifier attaches the file to your reply. 

4) Enter your reply and click Send. 

Unifier sends the email to the persons you specified. 
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Note: Once you reply to an external email, the communication will 
become part of Unifier mailbox system. To see your reply, or any other 
communication regarding this email after this point, look for it in the 
Inbox sub-node of the Navigator. Any reply you made to the email will 
appear in the Sent Items sub-node of the Mailbox node. Any email you 
forwarded will also appear in the Sent Items sub-node of the Mailbox 
node. 

Any reply you made to the email will appear in the Sent Items node of Mailbox. 

Any email you forwarded will also appear in the Sent Items node of Mailbox. 

To forward an email 

1) Open the email and click the Forward button. A forward email window opens. 

2) Click the To (and optionally, the Cc) button. The User/Group Picker opens. 

3) Select the user(s) to whom you wish to forward the message and click Add. The names 
appear in the Selected Users area at the bottom of the window. 

4) (Optional) To forward the email to external users, enter their addresses in the External Cc
field, separated by semi-colons (;). 

5) Click OK. Unifier forwards the email to the persons you specified. 

To delete an email 

On the Mailbox log, select the email and click the Delete button. To delete multiple emails, hold 
down the Ctrl key on your keyboard and select the emails. 

To print an email 

On the Mailbox log, select the email and click the Print button. To print multiple emails, hold 
down the Ctrl key on your keyboard and select the emails. 

To find a specific email 

1) On the Mailbox log, click the Find button. Unifier opens a Find window at the top of the log. 

2) Enter the search criteria. 

 To search for an email from a specific person, enter the person’s email address in the 
From field. 

 To search for an email with a specific subject line, enter the subject line in the 
Subjectcontaining field. 

You can enter partial addresses or words in any of these fields. Unifier will display all the 
emails that match the partial information you entered. 

To search for an email with some specific content in the message, enter that content in the 
Messagecontaining field. 

3) Click Search (or press Enter). 

Unifier will display the emails that match the criteria you entered. It will also identify the 
criteria by which you have searched the list in the "Current View: filtered by" line above the 
list. 

You can filter the available email items based on the folders that are present in Project Mailbox.  
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1) From the Project Mailbox, in the Linked Mail tab, click Add. 

2) In the Add from Project Mailbox window, click the Mailbox Folder drop-down list.  

3) Select from the list of the folders present for the Project Mailbox. The default value is 
Inbox. The list under Available Items block displays the emails in the folder that you had 
selected from the Mailbox Folder drop-down list. 

Collaborating with Team Members 

Unifier helps you to collaborate with your fellow team members through business processes. 

View shell information 

Shell information consists of the directory and the general information node. The Information 
node in the Navigator has two subnodes: 

 General is a log of general information BP records. 

 Directory is a list of shell team members 

General records originate as single-record BPs—only one record exists per shell. The General 
log is useful for shell-specific information that only needs to be documented on a single form. 
You can use it to easily categorize and find big-picture shell information. An example is general 
shell data or descriptions. 

To access shell information 

1) Open a shell 

2) In the Navigator, choose Information > General. The log displays the available records. 

3) To open a record, select it and click Open. 

To view the shell directory 

1) Open a shell. 

2) In the Navigator, choose Information > Directory. The Directory log opens, listing the shell 
team members and their contact information. 

Contact shell team members 

You can view the contact information of team members, and send them email or Mailbox from 
within Unifier. If there are many team members, you can use the search function to find a 
particular member. 

To find a shell team member 

1) Open the shell Directory and click Find. 

2) Choose which information to search by in the Search By selection list (for example, first 
name). 

3) Enter search criteria in the Search for field (for example, enter all or part of the first name), 
and click the Search button. 

To view a team member’s user profile 

1) In the Directory, select the user from the list and click Open. The View User Profile window 
opens. 
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2) In the Contact Information selection list at the top of the window, choose one of the 
following: 

 Current shell name: Displays contact information specific to the current shell, such as the 
onsite address or cell phone. 

 Company Contact Information: This is the member’s company contact information. 

To send an email using an external email program 

Do one of the following: 

 In the Directory, select a team member’s name and click Send email. 

 In the team member’s User Profile window, click the email address. 

An email dialog box using your default email program (for example, Microsoft Outlook) opens. 
The To: field is populated automatically with the member’s email address. Email sent through 
your external email program is not saved as part of the Primavera Unifier shell record. 

Auto-Population and Reverse Auto-Population in Shells 

Fields on a business process in a child shell can be setup in uDesigner to auto-populate from 
the attribute form of the current shell or any parent shell, or to auto-populate from the upper form 
of a single-record non-workflow business process under any parent shell. Also, a field on a shell 
attribute form can be setup to auto-populate from the attribute form of any parent shell, or from 
the upper form of a single-record business process under any parent shell. 

For example, a bank can have multiple banking centers. When a new banking center is 
commissioned, then a project shell can be used to manage the construction details of the 
banking center. A Work Order business process, which is created under the project shell 
contains details including physical characteristics from the Site shell. In this example, that 
includes the building color, which is auto-populated to the Work Order business process so that 
the building is painted the correct color. 



Working with Unifier Programs, Shells, and Projects

49

Note: If a shell is moved to a new place in the shell hierarchy, fields that 
are auto-populated for that shell retain the values that were populated 
when the shell was initially created. Auto-population does not reoccur 
when a shell is moved in the shell hierarchy. 

Reverse auto-population in shells 

Certain data elements support reverse auto-population. These are specified in uDesigner. 
Reverse auto-population means that some values can be automatically updated when other 
values are modified in a BP form or shell attribute form. 

Note: Reverse auto-population does not occur for shells with View-Only 
status. 

Depending on the set up in uDesigner, reverse auto-population can occur in these instances: 

 Changes to the data elements in a child shell’s attribute form can result in changes to the 
attribute form of any parent shell in the shell hierarchy 

 Changes to data elements in a BP detail form under a child shell can result in changes to the 
current shell attribute form or any parent shell attribute form in the shell hierarchy 

For example, When a new banking center is commissioned then a shell instance is used to 
construct the banking center. The parent shell needs to be updated with data from the Attribute 
forms of the child shell and from BPs within the child shell. 

Also, data stored in a Code and Records-based Manager (such as a Parts Manager) may 
change based on company-level or project/shell-level BPs, and those changes need to reverse 
auto-populate back to the attribute form. 
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Financial Period in Shell 

Depending on the financial period selected at the Shell level, when the user tries to create a 
scenario under Portfolio Manager, the user will see the list of projects with the same financial 
period present in the respective Shell options, only.  

If the user has selected a financial period at the Shell level, then the selected option overrides 
the financial period coming from Portfolio Manager by way of configuration. 

The same selected financial period will also be used under Cash Flow curves, for the time scale 
of the financial period type. 

The user is able to change the financial periods when there are no cashflows associated with 
that financial period. 

Accordingly, when the Cash Flow is refreshed, it uses the new period structure. 

If the user selects a period from the period picker, in the Shell details window, then the selected 
period will be used across Cash Flow curves (if time scale type is financial period) and Portfolio 
Manager. 

Working with Gates and Phases 

Gates allow you to assess the quality and integrity of a shell throughout its life cycle. A series of 
gate conditions are defined and tracked for each phase of the shell. Each gate condition is 
evaluated against the shell data and is marked complete if the conditions are met. When all the 
conditions are met, the shell moves to the next phase either automatically or manually, based on 
the configuration. 

Phases and gate conditions are configured in the Gates Setup in Administration Mode. 

You can use the Gates dashboard when working with shells to do the following: 

 Monitor the progress of phases 

 View phase conditions and their definitions 

 Run a gates process 

 Manually override a gate condition 

 Manually advance a phase 

View gate condition details 

To access the Gates dashboard 

1) In User Mode, open a shell. 

2) In the Navigator, click Gates. The Gates dashboard opens. 

3) Do one of the following: 

 Select a phase and click the Edit button on the toolbar. Click the View button below the 
Gate Condition pane. The Edit button is available if the gates setup is active. 

 Double-click a gate condition in the Gate Condition pane. 
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The Edit Gate Condition window opens. This is a view-only window. The General tab 
displays the data type associated with the gate condition. The Query tab displays the data 
element and trigger condition for this gate condition. 

Validate gate conditions manually 

You can manually validate conditions, which is the same validation that is performed during 
scheduled runs. The dashboard is updated to show any changes to the gates conditions. 

Note: Your Administrator can configure that Gates conditions are 
validated on each Gates run. 

To manually run gates 

In the Gates dashboard, click the Refresh button. 

If a gate condition is met, it is marked as complete. If all gates conditions are have been met for 
a shell phase, and Automatic Advancement is set, the shell phase advances to the next phase. 

Edit phase details 

To edit phase details 

1) In the Gates consoles, select a phase and click the Edit button. The Edit Phase Detail 
window opens. 

2) Do any of the following: 

 Mark a gate condition as complete by selecting the Complete checkbox next to it. 

 Mark a completed gate condition as not complete by deselecting the Complete
checkbox. 

 Select and view gate condition details. 

 Add or view general comments. 

This item Does this 

Gates Condition 
list 

Displays the gates conditions that must be met for the selected 
phase. 

Complete 
checkbox 

Select the checkbox to flag the gate condition as complete. 

Ignore 
Condition 
checkbox 

Select the checkbox to override the gate condition requirement for 
this phase. 

View button 

Click View to open the view-only Edit Report window. The General 
tab displays the data type associated with the gate condition. The 
Query tab displays the data element and trigger condition for this gate 
condition. 

General 
Comments 

Click the button to add or view general comments associated with this 
phase. 
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Add/View 

Advance a shell to the next phase 

After the gate conditions have been met for a phase, you can manually advance a shell to the 
next phase. 

To advance to the next phase 

1) In the Gates console, click the Advance to Next Phase button. 

2) In the confirmation window, click Yes. 

3) The system validates whether all gates conditions have been met for that phase. If all gates 
conditions are complete, the shell advances to the next phase. If any gate conditions have 
not been met, you can do the following: 

 Manually mark a gate condition as complete. 

 Select the Ignore Condition checkbox to override the gate condition requirements. See 
Edit phase details (on page 51). 

 Select the phase and click the Edit button to view details about the phase and gate 
conditions to determine what needs to be done to meet the condition. 

Return to a previous phase 

You can return to a previously completed phase and make it the current phase. 

To return to a previously completed phase 

1) Select the phase to reset as the current phase. 

2) Do one of the following: 

 Select a gate condition and edit it so that it is no longer complete. 

 Add a new condition so that the completed phase is no longer complete. 

Add or view phase comments 

To add comments in a phase 

1) In the Gates console, select the phase and click the Edit button. The Edit Phase Detail 
window opens. 

2) Click the General Comments Add/View button. The General Comments window opens. 

3) Enter comments in the Text Comments window and click OK. 

Note: After you have saved a comment, it cannot be edited or deleted. 

To view comments for a phase 

 In the Gates console, click the General Comments View button at the bottom of the 
window. The General Comments window opens displaying existing comments. 

 In the Gates console, select the shell phase and click the Edit button. Click the General 
Comments Add/View button. The General comments window opens. 
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Monitoring Gates 

You can view results from prior scheduled gates runs. 

To view gate runs 

1) In the Gates console, click the Saved Gates Runs button. The Saved Gates Runs window 
opens. 

2) Select a gate run from the list and click Open. The results are available in a PDF file. PDF 
file names include the date and time of the gate run. 

3) Choose to view or save the PDF file and click OK. 

The audit log captures Ignore Condition flags and general comments. 

To view the gate audit log 

In the Gates console, select View > Audit Log. 

Integrating Activity Sheet for Multiple Shells 

Notes: 

 Permission for "Get / Set Activity Sheet Data" from Shell log are 
configured in Unifier Admin Mode while permissions to take these 
action from within a Shell (User mode) are given at Unifier User 
mode level. 

 The options listed here are not available from the User mode of the 
Shell log (CBS type Shell) window menu toolbar. 

To integrate multiple Shell instances with P6, switch to the Admin mode, go to a CBS type Shell 
and from the Shell log window perform any of the following operations: 

To get an activity sheet data: 

1) Click File from the menu. 

2) Select Get Activity Sheet Data. 

3) Select one of the following choices: 

a. All Shells 

b. Selected Shells 

c. Filtered Shells 

d. History 

To send an activity sheet data: 

1) Click File from the menu. 

2) Select Send Activity Sheet Data. 

3) Select one of the following choices: 

a. All Shells 

b. Selected Shells 
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c. Filtered Shells 

d. History 

When in Admin mode, the following options are available in the CBS type Shell (in the Shell log 
window) toolbar: 

 Get Activity Sheet Data 

 Send Activity Sheet Data 

The following explains the options above in details: 

 Get Activity Sheet Data > All Shells

You can select this option without having to select a Shell from the log. 

 Get Activity Sheet Data > Selected Shells

You can select this option only when you select at least one Shell instance from the log.  

 Get Activity Sheet Data > Filtered Shells

You can select this option after filtering Shells by using the Find option in the Shell log. 

 Get Activity Sheet Data > History

Similar to the History option in other Unifier modules, you can select this option to view the 
history of a "Pull" action to see whether a request has been submitted successfully, or not. 

 Send Activity Sheet Data > All Shells

You can select this option without having to select a Shell from the log. 

 Send Activity Sheet Data > Selected Shells

You can select this option only when you select at least one Shell instance from the log. 

 Send Activity Sheet Data > Filtered Shells

You can select this option after filtering Shells by using the Find option in the Shell log. 

 Send Activity Sheet Data > History

Similar to the History option in other Unifier modules, you can select this option to view the 
history of a "Pull" action to see whether a request has been submitted successfully, or not. 

Note: Each time you initiate a "Get" data or a "Send" data action, the 
systems displays a confirmation message. Click OK on the message 
window to exit. 

Working with Multiple Document Manager Attribute Forms 

Within the Shell Details, you can select which attributes forms to use for the Document Manager, 
for both folders and documents.  

From the Options tab, you can define which attribute form (Document Manager Attribute 
Form) to use for the document/folder. Once you define the form, the corresponding Document 
form value is displayed in the Document properties (Document Manager Attribute Form 
Used). 

 By default, the attribute form (marked as system-defined in Document Manager) can be 
selected, and the corresponding document attribute form is used to determine the DMS 
structure. 
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 Only the active DM configuration forms are available for selection.  

 If you decide to change the attribute form for an existing shell, Unifier displays a message. 

If you change the attribute forms that are being used (which results in user views within the 
Document Manager containing fields that are no longer in the attribute form), then Unifier: 

 Removes the fields from the view 

 The related field columns will no longer be seen. 

For Columns that are added in the user view due to change in attribute form, the information 
is retrieved, if it exists. 

In case a previous active Document Manager configuration (in a shell) is marked as inactive, 
the DMS structure keeps that attribute form structure. When you open the shell details, the 
Document Manager Attribute is defaulted to system-defined attribute form because the 
previous configuration has been marked as inactive. The Document Manager Attribute Form 
User will show the previous DM attribute form that is kept by the shell. If you click OK, Unifier 
displays a message, informing you of this change. 

In case if a previous active Document Manager configuration (in a shell) is deleted because the 
associate folder attribute form was deleted, the DMS structure is defaulted to the system-defined 
attribute form of a supported DMS structure for the shells. When you open the shell details, the 
Document Manager Attribute is defaulted to system-defined attribute form because the 
previous configuration has been deleted. The Document Manager Attribute Form Used will 
show the system defined DM attribute form that is kept by the shell. If you click OK, Unifier 
displays a message, informing you of this change. 
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Unifier Projects 

A project is a "collaboration space" that allows project users to collaborate on and coordinate the 
execution of a project. Related projects can be grouped together under a program. If you are a 
member of a project that is part of a program, you may be a member of that program. 

As a Unifier user, you may be part of a sponsor company or a partner company (or possibly 
both). Sponsor companies can commission and administer projects and programs. Partner, or 
member, companies (e.g., subcontractors and vendors) work with sponsor companies to 
complete projects. 

Note: User access and permission levels for all functions are controlled 
by the Company Administrator. Contact your Company Administrator if 
you have questions regarding access. 

Within Unifier, a shell is a construct that contains sub-shells. Shells are like standard projects, 
but offer more functionality and flexibility in terms of how you work with them in Unifier. 

Note: Your Administrator can migrate standard projects to CBS shells. 

Shells allow users to manage different modules. Projects are also shells that are pre-defined in 
Unifier. The Shell Manager allows shell types to be defined in uDesigner. Administrators can 
later create one or more instances under each shell type in Unifier. Each instance can have its 
own business process, cost manager, reporting module, or other modules as needed. 

In This Section 

Open a project ......................................................................................................... 57 
What you can do in a Project ................................................................................... 58 
About Project Statuses ............................................................................................ 60 
Working with the Project Summary .......................................................................... 61 
Managing Project Alerts .......................................................................................... 65 
Working with Mailbox (Projects) .............................................................................. 67 
Distributing the Project Mailbox Email Address to Users ......................................... 76 
Working with Tasks, Notifications, and Drafts Nodes ............................................... 76 
Working with your Project Information ..................................................................... 77 
Working with Gates ................................................................................................. 78 
Working with E-Signatures ...................................................................................... 81 

Open a project 

Open a project to access the project functions and its tabs (see below.) Projects are listed on the 
Standard Projects tab. For details on navigation, refer to Unifier General User Guide. 
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Note: Your company may have configured the navigation so that the 
labels on the navigation tabs across the top or nodes on the left 
Navigator may differ from the default labels discussed here. 

To access your projects 

Go to the Standard Projects tab and switch to User mode. The Project log opens, listing all of 
the projects to which you have access. The log shows: 

 Number: The number assigned to the project. 

 Project Name: The name of the project. 

 Company Name: The sponsoring company for the project. This may be your own 
company or another company for which your company is a partner company in the 
project. 

 Status: The status of the project. 

 Asset Name: If the project has been associated with a company asset, the asset will be 
listed in this column. 

Refer to Unifier Programs, Shells, and Projects User Guide for details. 

To open a project 

Select a project from the Projects log and click Open. The project home page opens, providing 
an overview of the project. 

When you open the project home page, the Navigator expands, providing access to project-level 
features and business processes. 

What you can do in a Project 

The Navigator displays the project-related Unifier features that you have permission to access. 
Depending upon the modules your company has set up and your access permissions, the 
following project functions are available in the Navigator. 

The list below shows the default Navigator appearance. Your navigator may differ, but the basic 
functionality will be the same. The company administrators can configure the User mode 
Navigator (Company Workspace > Admin mode > Configuration > User Mode Navigator) to 
better suit business needs. For example, your company administrator can create additional 
nodes to store business process records, renaming some of the nodes mentioned below, an so 
forth. 

Based on the deployment of your user mode navigators, Unifier displays the Tasks, 
Notifications, and Drafts nodes in the respective Company Workspace and Project/Shell (User 
mode). The following table provides short description about the default Navigator nodes 
(Company Workspace and Project/Shell). 

Node Description 

Summary The Project Summary provides a snapshot of the overall project. You can 
use the Summary - Standard View or customize your own summary 
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Node Description 

page (Summary - User View). Refer to Unifier Programs, Shells, and 
Projects User Guide for details. 

Alerts You can create customized alerts to alert you to a condition or event in 
Unifier that you specify. Refer to Unifier Programs, Shells, and Projects 
User Guide for details. 

E-Signature
s

When a Send for E-Signature action is taken, and one or more 
documents are sent to Unifier users (Internal users), then an entry is 
made in the E-Signatures node to enable the user to act on the 
E-Signatures task.  

Tasks Not available for View-Only projects. Lists current business process tasks 
that have been assigned to you. Refer to Unifier General User Guide for 
details. 

Notification
s

Available for View-Only project, but you cannot add general comments. 

Drafts Not available for View-Only projects. Lists the drafts of the business 
processes. 

Mailbox An internal Unifier email feature that allows Unifier project team members 
to communicate with each other and maintain a record of the 
communications. For projects with View-Only or Inactive status, Mailbox 
is available for viewing, but you cannot send, edit or delete messages. 

The Mailbox is also the repository that collects external emails (and 
attachments) related to the project. These emails can come from project 
members or from external users who do not use Unifier. From the 
Mailbox, project users can forward the emails to appropriate members, 
flag them for review, and reply to them. In addition, these external emails 
can be linked to business process records. Refer to Unifier Programs, 
Shells, and Projects User Guide for details.  

Information In a project, this node has two sub-nodes: Directory and General. The 
Directory node lists the project team members. The General node lists 
the simple-type business processes. Refer to Unifier Programs, Shells, 
and Projects User Guide for details. 

Gates Displays project phase and gates information, and enables manual or 
automatic advancement of project phases. Refer to Unifier Programs, 
Shells, and Projects User Guide for details. 

General In a company, it lists the simple-type business processes. Refer to Unifier 
Business Processes User Guide for details. 

Asset 
Manager

In a company, it lists assets. Refer to Unifier Managers User Guide for 
details. 
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Node Description 

Configurabl
e Modules

Provides a flexible coding structures that allow you to analyze your data. 
The Configurable Modules node behaves like any other module in the 
Unifier, and you can have up to 25 Configurable Managers. Refer to 
Unifier Managers User Guide for details. 

Data 
Manager

A collection of BP logs storing project-level business processes not 
stored in project logs. 

Cost 
Manager

Access project-level Cost Manager functions (cash flow, cost sheet, 
earned value, funding, schedule of values). Refer to Unifier Managers 
User Guide for details. 

Document 
Manager

Repository of project documents, allowing collaboration, revision control, 
markups, and so forth. Refer to Unifier Managers User Guide for details. 

Planning 
Manager

In a company, it enables you to create, organize, manage, and update all 
company or project/shell planning initiatives from conception to 
completion. Refer to Unifier Managers User Guide for details. 

Resource 
Manager

Manage staff resources and role information. Refer to Unifier Managers 
User Guide for details. 

Schedule 
Manager

Manage project schedules, and import other related schedule files. Refer 
to Unifier Managers User Guide for details. 

Logs Primary storage of transaction and other project business processes of 
the project. Refer to Unifier General User Guide for details. 

Company 
Logs

Primary storage of transaction and other project business processes of 
the company. Refer to Unifier General User Guide for details. 

Reports Access to system and user-defined reports. Refer to Unifier General User 
Guide for details. 

About Project Statuses 

Your project can have one of four statuses: 

 Active: A live, in-progress project. 

 On-Hold: The initial project status. On-Hold projects are listed on the projects log, but you 
cannot work with them. 

 View-Only: View-Only projects can be viewed, printed, exported, and included in reports. 
You cannot modify any data in View-Only projects. This allows you to view past projects 
without allowing changes to these projects. 

 Inactive: Used to suspend project usage. Inactive projects are visible to Administrators, but 
not to end users. Only System and Project Administrators (users with Modify Status rights) 
can reactivate the project. 
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Note: If automatic status update is enabled on a project, the status of the 
project can change from Active to an inactive status (On-Hold, 
View-Only, Inactive). The change of status is set up by the Administrator, 
and is based on defined triggering conditions. For example, if a project is 
close to exceeding its funding, it might make sense to put it On-Hold 
while funding matters are discussed. Your project administrator must 
manually change the status back to Active when you are ready to restart 
the project. 

The Project Administrator will receive email notification when the status of a project changes. 
The change of project status could occur due to a manual change, bulk update, through Web 
Services or a CSV file, or through automatic update. 

Working with the Project Summary 

The project summary provides a snapshot of the overall project. You can configure what 
information is displayed in your project summary. There are two available views of the project 
summary: 

Summary - Standard View: The standard view of the project summary displays an overview of 
the project: 

 Project name and number, project administrator, and the number of people on the 
project. 

 Project schedule data, including schedule tracking information. 

 Cost data relative to expenses incurred on the project to date from the project cost sheet. 
Total amounts are displayed and rounded to the nearest integer. "Invalid" displays for 
any entry that contains an invalid entry in a Cost Manager formula. 

 Current tasks and their progress. 

 Project-level business process records. Click a business process on the list to display the 
number of records that exist for that business process. 

 From the View By selection list, choose Status (displays the total number of project 
records for each business process and the current status) or Originating Company
(displays the total number of project records originated per company, listed by company 
short name; applicable if your partner companies can create business processes for the 
project). 

Summary - User View: You can customize the project summary to display virtually any 
reportable project-related information in table or graphical format. The summary information is 
pulled from summary-type, user-defined reports or from preconfigured standard data-type 
reports. 

You can drill down to the respective log window by clicking a hyperlink from a summary report 
block. 

To access the project summary 

1) Open a project and click Summary in the Navigator. 
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2) Click the View menu, and choose Standard to view the standard view or User to view the 
user-defined view. 

3) Click a link to jump directly to the respective log window. 

To print a project summary 

1) Open a project and click Summary in the Navigator. You can print both the user view and 
the standard view. 

2) From the File menu, click Print Preview. The preview window of the summary opens. 

3) Click the Print icon in the upper right corner of the window. 

Configure your Project Summary 

To help you keep track of the information that is most useful to you, you can customize the 
information that is displayed in the Project Summary window. Each part of the summary page is 
called a block. The data shown in a block can be in table form, a bar graph, or a pie chart. The 
summary page displays blocks on the right or the left. 

You can add, edit, view, or delete summary reports as described below. You can customize how 
the summary report data is arranged in the Project Summary window, including displaying it on 
the left or right column, arranging the order of the display, and displaying the information as a 
table, bar chart, or pie chart. 

The data that is displayed in this view is generated from summary-type, user-defined reports. 
Each block represents one report. 

Note: Unifier displays the Tasks, Notifications, and Drafts nodes, in 
the respective Company Workspace and Project/Shell, based on the 
deployment of your user mode navigators. 

Available project-level standard reports 

Name Drill down to Default 

<BP Name> Count by 
Status 

BP Log 

<BP Name>% by Status BP Log 

<BP Name> Count by 
Company 

BP Log 

<BP Name>% by 
Company 

BP Log 

<BP Name> Count by 
User 

BP Log 

<BP Name>% by 
Creator User 

BP Log 

<BP Name> - Tasks by 
User 

Project > Tasks 
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Name Drill down to Default 

<BP Name> - Tasks All 
Users 

Project > Tasks 

Record Count per BP 
(for current user) 

BP Log based on which BP link was 
clicked 

Yes 

Record% per BP 
BP Log based on which BP link was 
clicked 

All Users (by company) 
Project > Project Information > Project 
Directory 

Logged in Users (by 
company) 

Project > Project Information > Project 
Directory 

Yes 

Current User Task 
Count 

Project > Tasks Yes 

All User Task Count No drill down 

Total Documents Drill down to Document Manager Yes 

To add reports to the user view 

1) Create summary-type reports that include the information that you want to display in the 
summary. For details about user-defined data types refer to Unifier General User Guide. 

2) Open a project and click Summary in the Navigator. The Summary window opens. 

3) Click the View menu and choose User. 

The initial reports included in the summary are displayed in table format. You have the option 
to modify how these reports display, remove them from the summary view, or add other 
summary reports. 

4) From the Edit menu, choose one of the following: 

 Left Column: To add information to the left side of the window 

 Right Column: To add information to the right side of the window 

The Left Column Blocks or Right Column Blocks window opens. 

5) Do one of the following: 

 To add a user-defined summary report, click Add Custom. The Custom Summary Block 
window opens. Complete the window and click OK. 

 To add a pre-configured, standard data-type report, click Add Standard. The Standard 
Summary Block window opens. Complete the window and click OK. 

6) Use the information in the first table below to complete the fields in the Add Custom window. 

7) Use the information in the second table below to complete the fields in the Add Standard 
window. 

8) Click Close. The Project Summary - User View window will update to include the new report. 
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In this field Do this 

Report Name 

Click the Select button. The User-Defined Reports window opens, 
listing the available summary reports. Select a report from the list, and 
click the Open button. (If the list is long, you may click the Find button 
and enter search criteria to help locate a specific report.) 

Note: Note: Reports that are already used in the summary page are 
shown with a check mark. You can use a report more than once. For 
example, you might want to include the same report in both table and 
pie chart formats. 

Description This is populated automatically with the report description, if one exists.

Block Title 
This will appear over the data on the summary page. By default, the 
field will show the report name, but is editable. 

Display Type Choose to show the data as a bar chart, pie chart, or table format. 

Show Result 

Choose one of the following: 

 Actual Value: Shows the actual value of what is being reported 
(number of records for a particular BP type, etc.). 

 Percent distribution of total: Calculates the value as a 
percentage of the total (the percentage of total records to which a 
BP type corresponds, etc.). 

Show Total 

Select this checkbox if you want to display the total value of the data. 
This will vary, depending on what data is used in the report. For 
example, it may include the total number of records, total currency 
amount, etc. 

In this field Do this 

Report Name This field will auto-populate with the selection from the Report On field. 

Data Type Choose a standard data type to add to the summary. Choices include: 

Business Process 

Document Management 

Active Task Information 

Users 

List of project business 
processes 

Report On 
The selection list is dependent on what is chosen from Data Type. 
Choose from the selection list. The Report Name field will auto-populate 
with the standard report. 

Block Title 
This will appear over the data on the summary page. By default, the 
field will show the report name, but is editable. 

Display Type Choose to show the data as a bar chart, pie chart, or table format. 
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Show Result 

Choose one of the following: 

 Actual Value: Shows the actual value of what is being reported 
(number of records for a particular BP type, etc.). 

 Percent distribution of total: Calculates the value as a percentage 
of the total (the percentage of total records to which a BP type 
corresponds, etc.). 

Show Total 

Select this checkbox if you want to display the total value of the data. 
This will vary, depending on what data is used in the report. For 
example, it may include the total number of records, total currency 
amount, etc. 

To move or delete blocks on the Project Summary - User View 

1) Open the Project Summary - User View. 

2) From the Edit menu, choose one of the following: 

 Left Column: To add information to the left side of the window 

 Right Column: To add information to the right side of the window 

The Blocks window opens. Blocks are listed in the order in which they appear on the page. 

3) To move a block, select it and click Move Up or Move Down. 

4) To delete a block, select it and click Delete. 

To change the display type, title, or other block property 

Select the block and click Open. Make changes as necessary and click OK. 

Managing Project Alerts 

You can create customized alerts to alert you to a condition or event in Unifier that you specify. 
For example, you might set up an alert that will send you an email or Mailbox message letting 
you know that a fund amount on the funding sheet has reached a certain level. 

Alerts are created by creating an alert-type user-defined report. 

To create an alert 

1) Create an alert report in user-defined reports. For more information about user-defined 
report data types refer to Unifier General User Guide. 

2) Open a project and click Alerts on the Navigator. The Alerts log opens. 

3) Click New. The Alert window opens. Complete the window as described in the table below. 

4) Click OK to close the Alert window. 

In this field: Do this: 

Report Name 

Click the Select button. The list of user-defined alert reports for 
the project opens. Select a report from the list, and click the 
Open button. (If the list is long, you may click the Find button 
and enter search criteria to help locate a specific report.) 

Note: Reports that are already used to create an alert are 
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In this field: Do this: 

shown with a check mark. You can create more than one alert 
for each report. 

Description 
This is populated automatically with the report description, if one 
exists. 

Alert Title 
This will appear as the title of the alert in the log and on the alert 
sent. By default, the field will show the report name, but this is 
editable. 

Frequency 

Choose the frequency that you want the alert to be sent when 
the trigger condition is met: 

Never: Alerts will not be sent. 

Hourly: Alerts will be sent every hour, at about 20 minutes past 
the hour. 

Daily: Alerts will be sent daily at about 2:20 a.m. 

Weekly: Alerts will be sent on Mondays at about 2:20 a.m. 

Monthly: Alerts will be sent on the first day of the month, about 
2:20 a.m. 

Times may vary somewhat. The times noted above refer to 
server time, that is, the time according to the Unifier server 
being used. (Unifier servers operate on Pacific Standard Time.).

Note: If you choose any frequency other than Never, you must 
specify a method and message. 

Method 
You may select one or both of the following methods to be 
notified of the alert: Email (the email on your user profile will be 
used) or Mailbox. 

Message 
Type a message that you want to be included in the alert. 
Remember that this is an alert that only you will see, so enter as 
much or as little detail as you need. 

To edit alerts 

1) Open a project and click Alerts on the Navigator. The Alerts log opens. 

2) Select an alert and click Open. The Alert window opens. 

3) Make changes to the alert as needed and click OK. 

To delete an alert 

Open a project and click Alerts on the Navigator. The Alerts log opens. Select an alert and click 
Delete. 
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Working with Mailbox (Projects) 

The project Mailbox is an internal Unifier email feature that allows Unifier project team members
to communicate with each other and maintain a record of the communications. The project
Mailbox interface is similar in functionality to common email programs such as Microsoft 
Outlook. The project Mailbox supports file attachments and emails can be sent between project 
team members and to external email addresses.  

Note: The external email cannot be sent directly to the project Mailbox. 

A copy of every mailbox communication is saved in a central folder controlled by the project 
administrator. These communications become part of the project record. The project or company 
administrators must grant users permission to access the project Mailbox folder. 

Depending on permissions, users can view all messages or only those in which they participated 
(sent or received). Permission can also be granted to delete items in the project Mailbox folder. 
Once deleted, the communications are not recoverable.  

Note: Users who sent or received the deleted message may still retain 
copies of these messages in their own Inbox or Sent folder.  

For additional information see Home Page (Mailbox). 

You can link the messages in the project Mailbox to specific business process records. See 
Linking Mailbox Messages to a Record for more information. 

View and find Mailbox Messages 

The Mailbox feature is project-specific, and the full functionality is accessed at the project level. 
A cross-project listing of your Inbox and Sent items can also be accessed in the Mailbox node 
directly under Home. 

To access project Mailbox 

1) Open a project and switch to User mode. 

2) Click Mailbox in the left Navigator. The Mailbox folders expand: 

 Drafts: Displays Mailbox messages that you have drafted but not yet sent. 

 Inbox: Displays messages sent to you. 

 Sent Items: Displays messages that you have sent. 

 Deleted Items: Displays items that you have deleted from one of the other folders. 

 Project Mailbox : Stores copies of all Mailbox messages sent between project team 
members. Access to this folder must be granted through permission settings. 

To view all of your Mailbox messages across projects 

1) Go to the Home page. 

2) Click Mailbox in the left Navigator. All messages residing in all project Mailbox Inbox and 
Sent folders are listed. 

3) To open a listed message, select it from the list and click Open. You will be directed to the 
Project Mailbox Inbox or Sent folder containing the message, and the message will open. 



Unifier Programs, Shells, and Projects User Guide

68

To search for a specific Mailbox message across projects 

1) Go to the Home page. 

2) Click Mailbox in the left Navigator. All messages residing in all project Mailbox Inbox and 
Sent folders are listed. 

3) Click the Find button. 

4) Enter search criteria in the Subject Containing or Message Containing fields in the upper 
portion of the log window. 

5) Click Search. The log will list the messages meeting the search criteria entered. 

Send and Receive Mailbox Messages 

Mailbox functionality is similar to common email programs. In Mailbox, you can attach files, 
format text, flag the message, compose and save a draft of your response without sending it, 
and preview your message in a browser. 

You can correspond with your Unifier project team members through Mailbox, and send Mailbox 
to external email addresses. External email users cannot send email directly to Mailbox. 

Note: Mailbox messages can be linked directly to related business 
process records. For information about linking mailbox messages to a 
record refer to the Unifier Business Processes User Guide. 

To send a Mailbox message 

1) Open a project and switch to User mode. 

2) Select any Mailbox folder. 

3) Click New. A message window opens. 

4) Choose the recipients of the Mailbox message by doing any of the following: 

 Click To to select the primary recipients. The User/Group picker opens displaying project 
users. Select recipients from the Select Users list, and click Add. Click OK to close the 
picker. 

 To send a copy to another recipient, click Cc, and choose the recipients from the 
User/Group picker. 

 To send a copy to an external email address, enter the address in the External Cc field. 
Separate multiple external addresses with a semicolon (;). The recipient will see Unifier 
Notification in the From field, and will not be able to reply directly. 

 To send a blind copy (Bcc), click the View menu and select Bcc Fields. The Bcc button 
and External Bcc field become available on the Mailbox message window. 

5) Type the subject of the message in the Subject field. 

6) Type the body of the message in the text field. 

7) Click Send to send the message. 

To view or respond to a Mailbox message 

1) Access Mailbox by doing one of the following: 
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 Open a project and switch to User mode. In the left Navigator, select the Mailbox Inbox
folder. The Inbox lists all messages that have been sent to you. Unread messages are 
shown in bold text. 

 Go to the Home page. In the left Navigator, click Mailbox. All sent and received Mailbox 
messages across projects are listed. Unread messages are in bold text. 

2) Double-click on a message to view it. The message opens. 

3) To respond to the message, do one of the following: 

 To send a reply to the sender, click Reply. 

 To send a reply to the sender and other recipients of the original message, click Reply to 
All. 

 To forward the message to another recipient, click Forward. 

Note: Any file attachments will remain on forwarded messages. 

4) Type your response and click Send. 

To attach files to a Mailbox message 

1) Open the Mailbox message. 

2) Click Attach and choose one of the following: 

 My Computer: Attaches the file from your local system. The procedure is the same as 
for uploading files to the Document Manager. 

 Primavera Unifier Folder: Attaches documents from the Document Manager. The 
window opens, displaying the Project Documents files and folders. Select the files and 
folders to attach and click OK. 

Note: Folders are not attached. The contents of selected folders are 
attached in a flat list. Documents with duplicate file names will not attach. 

3) Click OK to add the file, and click OK to close the General Comments window. 

To flag a Mailbox message for follow-up 

1) Open an existing message, or create a new message. 

If you want to flag a message that you are replying to or forwarding, then open the message, 
and click Reply, Reply All or Forward. 

1) Click the Flag for Follow-Up button. The Flag for Follow-Up window opens. 

2) In the Flag to field, choose an action, such as "call," or "for your information." 

3) Click OK. The flag text appears at the top of the message. A red flag symbol will also display 
next to the message in the log. (You may need to refresh the log to see the flag.) 

4) If this is an existing message that you are flagging for yourself, you can simply close the 
message. If you are sending the message to someone else, add the recipients and send the 
message. 

To remove a Mailbox flag 

Click the Flag for Follow up button, and then click Clear Flag. 
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To format Mailbox text 

1) Open the Mailbox message. 

2) Select the text you want to format within the body of the message. 

3) On the Formatting toolbar, choose the formatting to apply to the text. 

To spell check Mailbox text 

1) When you are finished composing a Mailbox message, click the Spelling button on the 
toolbar of the message. The body text of the message is checked. 

2) Make spelling corrections as necessary and click OK. 

To print a Mailbox message 

1) Open the Mailbox message. 

2) Click the Print button. 

To print several Mailbox messages from the Mailbox log 

1) Navigate to a Mailbox log. 

2) Select the Mailbox records that you want to print. 

3) Click the Print button. 

To search for a Mailbox message 

1) In the Navigator, click on one of the Mailbox folders. 

2) From the toolbar, click the Find button. The Find box expands above the log. 

3) Do any of the following: 

 To search by the recipient (To field), click the Select button and choose the user from the 
User/Group picker. 

 To search by subject, enter a word or phrase in the Subject Containing field (partial 
entries are acceptable). 

 To search by message content, enter a word or phrase in Message Containing. 

 You can further refine the search by clicking the Items that are: drop-down list and 
choosing Read or Unread. 

4) Click Search. The messages meeting your search criteria will be listed in the log. 

To delete Mailbox messages 

1) Do one of the following: 

 From a Mailbox log, select the message and click Delete. 

 From within a Mailbox message, click Delete on the toolbar. 

The message is moved to the project’s Deleted Items folder. 

2) To permanently delete a message, select it from the Deleted Items folder and click Delete. 
Click Yes to confirm that you are permanently deleting the message. 

Note: When you delete a message from your account, a copy of the 
message remains in the central project record: the Project Mailbox 
folder. Messages deleted from the Project Mailbox folder are 
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permanently deleted. 

Link Mailbox Messages to Business Process Records 

Mailbox messages can be linked directly to BP records through the Linked Mailbox link at the 
bottom of the BP form. For information about linking mailbox messages to a record refer to the 
Unifier Business Processes User Guide. 

Note: This option is available only in BPs that have been set up to 
accommodate linked Mailbox messages. The ability to attach messages 
or view attached messages depends on the user’s Mailbox View 
permissions. Reply, reply all, and forward messages sent from a linked 
Mailbox will also be automatically linked to the BP. 

To view the list of BP records to which a Mailbox message is linked 

1) Open the Mailbox message. 

If the message is linked to a BP record, the upper portion of the message will display the 
following: 

"This Mailbox and any future replies are linked to records. Show list" (where Show list is a 
hyperlink). 

2) Click on the Show list hyperlink to view the list of BP records to which the Mailbox is linked. 

Additional Information about Using the Project Mailbox 

External emails are important communications that need to be included in projects. Such emails 
can come from project members or from external users who do not use Unifier.  

Note: To use any of the mailbox features, you must have permissions. 

These email communications (and any attachments) are collected in a central repository for the 
project, called the Inbox  (Mailbox > Project Mailbox > Inbox ) so that project members can 
use them in managing and documenting the project. Once such emails reside in the Inbox , the 
project users can view them, forward them to appropriate members, flag them for review, and 
reply to them. In addition, the project users can link these emails to business process records.  

Note: The external emails that have been blind carbon-copied (Bcc’d) 
are not collected by the Inbox. 

Creating additional folders 

1) Go to your shell/project (User mode). 

2) Click Mailbox to expand. 

3) Click Project Mailbox to expand. 

4) Click Inbox to open the Inbox log. 

If you have the View permission for Inbox sub-node, then you can view all folders under the 
Inbox sub-node. 

5) On the toolbar, click the folder icon to open the Folders window. 
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You can see the folder icon only if you have the Create/Manager Folders permission. 

6) Click the plus icon to open a new row. 

7) Under the Name column, double-click the empty cell and enter a name for the new folder. 

 This field cannot be empty. 

 The maximum character length is 250. 

 You cannot use a name that already exists. 

8) Under the Email Address Code column, double-click the empty cell and enter a code. 

 This field cannot be empty. 

 The maximum character length is 120. 

 You cannot use a code that already exists. 

9) Click OK. 

Your newly created folder appears in the existing list of folders below the Inbox node. The 
positioning of the folders below the Inbox node is according to the ordering of rows in Folders
window. You can drag and drop rows in the Folders window in order to reorder the folder 
position in the navigator, on the left.  

Note: You can reorder more than one folder at the same time. 

In addition, you can double-click into any cell of the grid of an existing folder, in the Folders
window, and edit the folder properties (Name, Email Address Code). 

The email address is calculated by the system according to the Project Email Pattern that is 
defined in Unifier Configurator. As a result: 

 When the Project Email Pattern, in the Unifier Configurator, is configured to be the prefix, 
the email address of the folder will be: <Email Address Code for the folder>-<project email 
id>. For example, if the Email Address Code of a folder is "construction," and the project 
email id is"bostonGenHospital-slc05kuz@internal-mail.oracle.com," then the folder email 
address will be "construction-bostonGenHospital-slc05kuz@internal-mail.oracle.com." 

 When the Project Email Pattern is configured to be the suffix, the email address of the 
folder will be such that the Email Address Code gets appended to the very end of the 
project email id. For example, if the Email Address Code of a folder is "construction," and 
the project email id is "slc05kuz+bostonGenHospital@internal-mail.oracle.com," the folder 
email address will be 
"slc05kuz+bostonGenHospital+construction@internal-mail.oracle.com." 

When a user sends an email to the email address of a folder, that email automatically lands 
inside the correct folder. Additionally, if the user specifies an incorrect value of the Email 
Address Code, and the rest of the project/shell email address is correct, then that email 
automatically shows up in the Inbox sub-node under the Project Mailbox parent sub-node. 

The toolbar options for the new folder (below the Email Address) is the same as the toolbar 
options for the Inbox sub-node. The actions Move and Folder are visible based on permissions. 

The options View, Edit View, Refresh, Search and Find on Page are the same as in Inbox
sub-node. 
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The log layout listing the emails for a new folder is the same as for Inbox sub-node. Similar to 
Inbox sub-node, the user has the ability to move one or more emails from one folder to another 
using the right-click option > Move or using the Move option. 

By default, Inbox is available under Project Mailbox (Project/Shell > User mode > Mailbox > 
Project Mailbox > Inbox). You have ability to select Inbox, move it to the "Available Modules 
and Business Processes" section and then move it back below any other parent node in the 
"Selected Modules and Business Processes" section. 

When you move Inbox to the right section, the parent node Project Mailbox will disappear. 

When you move Inbox from the right to the left section below a new parent node, then Unifier 
inserts the Project Mailbox node as the direct parent node of Inbox. For example, if the original 
hierarchy was Folder A > Project Mailbox > Inbox, and the user moves the Inbox to the right 
section, and then moves it back to the left section below Folder B, then Unifier displays the 
hierarchy as Folder B > Project Mailbox > Inbox. In other words, the Inbox always resides below 
the Project Mailbox. 

You can send an email to unifier Project/Shell users giving them information about the additional 
email address of a Project/Shell. The email is a system-generated message with the following 
elements: 

Header: Email Address(es) for <project/shell number> - <project/shell name> 

Subject: Email Address(es) for <project/shell number> - <project/shell name> 

Body (text): This email is to inform you that a Unifier Mailbox has been setup for <project/shell 
number in bold chars> - <project/shell name in bold chars> 

You must use the following general format for the email address: <project/shell email id> 

If the Project/Shell contains additional folders, the following text between two forward slashes //: 

//To send messages, including file attachments to specific folders, use 
the following email address(es):

1. <Folder 1 name>: <Folder 1 email address>

2. <Folder 2 name>: <Folder 2 email address>

3. <Folder 3 name>: <Folder 3 email address>

... <and so on>

//

Note: If there are no additional folders, this text must not be contained in 
the email body. 

The email is a system-generated message. 

All emails received, or existing emails in the Project Mailbox, are in the Inbox node below the 
Project Mailbox parent sub-node. 

To open the Project Mailbox 

1) Open your project. 

2) In the Navigator, click to expand the Mailbox node (Project Mailbox > Inbox). The right 
pane displays a log of the contents of the Inbox. 
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To open an email 

On the Inbox log, double-click the email. Unifier opens the email. If there are attachments, the 
email will display an Attachments (n) link. To open an attachment, click the link and 
double-click the attachment on the list that appears. 

To flag an email for follow-up 

1) Open the email. 

2) Click the Flag for Follow-Up button. Unifier opens the Flag for Follow-Up window. 

3) In the Flag to field, choose the action you want for this email, such as "call," or "for your 
information." 

4) Click the Reply button to reply to the email, or click the Forward button to forward the email 
on to someone. 

When the recipient opens the message, the specific flag remark is shown across the top of 
the message. 

Note: To remove the flag, click the Flag for Follow-Up button, and then 
click Clear Flag. 

To move an email from one folder to another folder 

1) Go to Inbox and click the email that you want to move. 

2) Click Actions drop-down list and click to select Move. This opens the Move window. 

Alternatively, you can click the gear menu and select Move. 

3) In the Move window click to select the folder that you want to move the email into and click 
OK. 

The Move option is available only if more than one folder (including the Inbox) exists below the 
Project Mailbox parent sub-node, and you have the permission to view the Inbox. 

To create a folder 

1) Go to Inbox and click the folder icon. 

2) In the Folders window click the plus option to open a row on the grid. 

3) Double-click on each cell of this new row, under Name and Email Address Code columns, 
and enter the values. 

4) When finished, click OK. 

5) Ensure that you see the new folder under the Project Mailbox parent sub-node, below the 
Inbox sub-node. 

You can create new folders only if you have the permission to "Create/Manage" folders for the 
Project Mailbox. 

You can change the order of the folders by moving the rows in the Folders window. 

The order of folders arrangement below the Inbox node, in left-hand navigator, is according to 
the order of rows in the Folders window. The Inbox sub-node is always the top folder and directly 
below the Project Mailbox parent sub-node. 
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To delete a folder 

1) Go to Inbox and click the folder icon. 

2) In the Folders window click to select the row of the folder that you want to delete. 

3) Click the trash-can icon and click OK. 

To reply to an email 

1) Open the email and click the Reply button. 

Unifier displays the addressee’s email address in the External To field. You can add 
additional external addresses in this field, separated by semi-colons (;). 

2) (Optional) To add email addresses to the Cc line, click the Cc button. The User/Group Picker 
opens. 

a. Select the user(s) you wish to add to the message and click Add. The names appear in 
the Selected Users area at the bottom of the window. 

b. Click OK. 

3) (Optional) To attach a file to the reply, click the Attach button and choose My Computer or 
Primavera Unifier Folder. 

a. In the window that opens, select the file you want to attack, or browse your computer 
directories to locate the files to attach. 

b. Click OK. Unifier attaches the file to your reply. 

4) Enter your reply and click Send. 

Unifier sends the email to the persons you specified. 

Note: Once you reply to an external email, the communication will 
become part of Unifier mailbox system. To see your reply, or any other 
communication regarding this email after this point, look for it in the 
Inbox sub-node of the Navigator. Any reply you made to the email will 
appear in the Sent Items sub-node of the Mailbox node. Any email you 
forwarded will also appear in the Sent Items sub-node of the Mailbox 
node. 

To forward an email 

1) Open the email. 

2) To forward the email, click the Forward button. A forward email window opens. 

3) Click the To (and optionally, the Cc) button. The User/Group Picker opens. 

4) Select the user(s) to whom you wish to forward the message and click Add. The names 
appear in the Selected Users area at the bottom of the window. 

5) (Optional) To forward the email to external users, enter their addresses in the External Cc
field, separated by semi-colons (;). 

6) Click OK. Unifier forwards the email to the persons you specified. 

To delete an email 

On the Mailbox log, select the email and click the Delete button. To delete multiple emails, hold 
down the Ctrl key on your keyboard and select the emails. 
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To print an email 

On the Mailbox log, select the email and click the Print button. To print multiple emails, hold 
down the Ctrl key on your keyboard and select the emails. 

To find a specific email 

1) On the Mailbox log, click the Find button. Unifier opens a Find window at the top of the log. 

2) Enter the search criteria. 

 To search for an email from a specific person, enter the person’s email address in the 
From field. 

 To search for an email with a specific subject line, enter the subject line in the 
Subjectcontaining field. 

You can enter partial addresses or words in any of these fields. Unifier will display all the 
emails that match the partial information you entered. 

To search for an email with some specific content in the message, enter that content in the 
Messagecontaining field. 

3) Click Search (or press Enter). 

Unifier will display the emails that match the criteria you entered. It will also identify the 
criteria by which you have searched the list in the "Current View: filtered by" line above the 
list. 

Distributing the Project Mailbox Email Address to Users 

Usually, your Unifier Administrator distributes the email address of the Project Mailbox to all 
project participants, both within and outside of Unifier. You can also distribute this email address 
to other users you consider appropriate for the project. 

Ensure that you notify your Administrator of these new users. The Administrator must add the 
new email addresses to the approved email list for the project; otherwise, the Project Mailbox will 
not accept emails from these users. 

The Administrator can define the project email address in order to create a more meaningful 
name that is related to the project.  

To distribute the Project Mailbox email address 

Open the project home page and click the link shown for Email Address. 

When an external user replies to a notification email:  

 The address field of the form is automatically set to display the email address of the project. 

 The reply email is captured in the project mailbox. 

Working with Tasks, Notifications, and Drafts Nodes 

When you are part of a business process workflow, or have been invited to participate in a 
discussion group (Classic View only) within a business process, you are assigned a task.  

 Tasks are business processes that you are involved with and are in process. 
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 Notifications are business processes that you have been sent a copy but do not need to 
take action. 

 Drafts are business processes that you have worked on and saved but have not yet sent. 

You can access your tasks, notifications, and drafts in the following locations: 

 Home page 

Go Home page > click the nodes (Tasks, Notifications, Drafts) to open > from the log, click 
to open one of the items that required your attention, or you want to work with. 

 Company Workspace 

Go to Company Workspace > User mode > click the nodes  (Tasks, Notifications, 
Drafts) to open > from the log, click to open one of the items that required your attention, or 
you want to work with. 

 Project/Shell 

Go to your Project/Shell > User mode > click the nodes (Tasks, Notifications, Drafts) to 
open > from the log, click to open one of the items that required your attention, or you want 
to work with. 

Working with your Project Information 

You can access your project information from the Information node of that project: Your project 
> User mode > Information. 

The Information node as two sub-nodes that each provide more details about the project as 
explained below: 

 Directory

 General

Directory 

Contains a collection/log of the project-team members. and their contact information. 

Note: A printed version of the Project Directory can be generated using 
user-defined reports. 

To find a project team member: 

1) Click the Directory sub-node to open and click Find. 

2) Select which information to search by, in the Search By selection list, for example, First 
Name. 

3) Enter search criteria in the Search for field, for example, enter all or part of the first name. 

4) Click Search. 

You may view the contact information of fellow team members and even send email or Mailbox 
from within Unifier. 

To view a team member's user profile: 

1) In the Project Directory, select the user from the list and click Open. The View User Profile 
window opens. 
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Note: If a User Attribute design has been deployed from uDesigner by 
your Administrator, the content of this profile can vary. 

2) In the Contact Information selection list at the top of the window, choose one of the following: 

 Current Project: Displays contact information specific to the current project, such as an 
on-site address or cell phone. 

 Company Contact Information: This is the member's company contact information. 

To send an email using an external email program: 

Do one of the following: 

 In the Project Directory, select a team member's name and click Send email. 

 From the User Profile window, click the email address. 

This will open an email dialog box using your default email program (for example, Microsoft 
Outlook). The To: field will be populated automatically with the member's email address. 
Email sent through your external email program will not be saved as part of the Unifier 
project record. 

Note: You may also contact a team member using Mailbox. 

General 

Contains a collection/log of the general information business process records that may have 
been added to the project. Refer to Unifier General User Guide for details.. 

The listed BP records originate as single-record business processes. In other words, only one 
BP record exists for each BP, per project. The General log is useful for project-specific 
information that only needs to be documented on a single form. It is a way to easily categorize, 
and find, big-picture project information, for example, the overall project data or descriptions. 

To open a record, select it and click Open. 

Working with Gates 

Gates provides a structure to assess the quality and integrity of a project throughout its life cycle. 

Gates are, in essence, acceptance reviews following which a project can advance to the next 
phase in the project life cycle. For each phase of the project, a series of gate conditions are 
defined and tracked. Each gate condition is evaluated against actual project data and is marked 
complete if conditions are met. Once all conditions are complete, the project moves to the next 
phase either automatically or manually, based on the configuration. 

Phases and gate conditions are configured in the Gates Setup in Administration Mode. 

View the Gates dashboard 

The Gates dashboard allows you to: 

 Monitor the progress of project phases 

 View phase conditions and their definitions 
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 Run a gates process 

 Manually override gate conditions 

 Manually advance a project phase 

To access Gates 

1) Open the project and switch to User mode. 

2) Click Gates in the left Navigator. The Gates dashboard opens. 

View gate condition details 

To view gate condition details 

1) Open the Gates dashboard. 

2) Do one of the following: 

 Select a project phase and click the Edit button on the toolbar. Click the View button 
directly below the Gate Conditions pane. (The Edit button is available if the gates setup 
is active.) 

 Double-click a listed gate condition in the Gate Conditions pane of the dashboard (or 
select the gate condition and click the View button). 

The Edit Gate Condition window opens. This is a view-only window. The General tab 
displays the data type associated with the gate condition. The Query tab displays the data 
element and trigger condition for this gate condition. 

Validate gate conditions manually (refresh) 

You can manually validate conditions, which is the same validation that is performed during 
scheduled runs. The dashboard is updated to show any changes to the gates conditions. 

Note: Your Administrator can configure that Gates conditions are 
validated on each Gates run. 

To manually run gates 

1) Open the Gates dashboard. 

2) Click the Refresh button. 

If a gate condition is met, the gate condition is marked as Complete. If all gate conditions are 
found to have been met for a project phase (and if Automatic Advancement is Yes), then the 
project phase will advance to the next phase. 

Edit phase details 

To edit phase details 

1) Open the Gates console. 

2) Select a project phase and click the Edit button. The Edit Phase Detail window opens. 

3) Use the information in the following table to complete the window. 
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This item Does this 

Gates Condition 
list 

Displays the gate conditions that must be met for the selected phase. 

Complete 
checkbox 

Select the checkbox to manually flag the gate condition as complete. 

Ignore 
Condition 
checkbox 

Select the checkbox to override the gate condition requirement for 
this phase. 

View button 

Click the View button under the Gate Conditions list. The Edit Report 
window opens. This is a view-only window. 

The General tab displays the data type associated with the gate 
condition. 

The Query tab displays the data element and trigger condition for this 
gate condition. 

General 
Comments 
Add/View 

Click the button to add or view general comments associated with this 
project phase. 

Advance to the next phase 

After the gate conditions have been met for the current phase, you can manually advance a 
project to the next phase. 

To advance the phase to the next phase 

1) Open the Gates console. 

2) Click the Advance to Next Phase button. 

3) A confirmation window opens asking you to confirm the phase advancement. Click Yes to 
confirm. 

The system will validate whether all gate conditions have been met for that phase. If all gate 
conditions for that phase are complete, the phase can advance to the next phase. If all of the 
gate conditions have not been met, you can: 

 Manually mark a gate condition as complete. 

 Click the Ignore Condition checkbox to override the gate condition requirements. 

 Select the phase and click the Edit button to view details about the phase and gate 
conditions, and therefore determine what needs to be done to meet the gate condition. 

Return to a previous phase 

To return to a previously completed phase and set it as the current phase: 

1) Select the phase to reset as the current phase. 

2) Do one of the following: 
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 Select a gate condition and edit it so that it is no longer complete. 

 Add a new condition so that the completed phase is no longer complete. 

Add or view general comments 

To add general comments in a project phase 

1) In the Gates console, select the project phase and click the Edit button. The Edit Phase 
Detail window opens. 

2) Click the Add/View button. The General Comments window opens. 

3) Enter any comments in the Text Comment pane and click OK. Once you save a comment, it 
cannot be edited or deleted. 

To view existing general comments on a project phase 

Do one of the following: 

 In the Gates console, click the View button at the bottom of the screen. The General 
Comments window opens displaying existing comments. 

 In the Gates console, select the project phase and click the Edit button. Click the Add/View
button. The General Comments window opens. You can view existing comments or add a 
new one. 

View saved Gates runs 

You can view results from prior scheduled gates runs. 

To view saved gates runs 

1) Open the Gates console. 

2) Click the Saved Gates Runs button. The Saved Gates Runs window opens. 

3) Select a saved gates run from the list and click Open. Results are available in a PDF file. 
PDF file names include the date and time of the gates run. 

4) Choose to view or save the PDF file and click OK. 

View the Gates audit log 

To view the Gates audit log: 

1) Open the Gates console. 

2) Click the View menu and choose Audit Log. 

The audit log captures Ignore Condition flags and general comments. 

Working with E-Signatures 

Internal user

When a Send for E-Signature action is taken, and one or more documents are sent to Unifier 
users (Internal users), then an entry is made in the E-Signatures node to enable the user to 
act on the E-Signatures task.  
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The internal users are able to act on the E-Sign task from the: 

 E-Signatures node. 

 Email sent out to them from Unifier (if this is configured in the User Preferences > Email 
Subscription’ settings). 

When sending out an E-Signature request, for internal users, the To field in ‘Send for 
E-Signature’ window enables you to type-ahead user or group. You can select one or more 
users or groups and send E-signature request. 

In the User Preferences > Email Subscriptions tab, use the E-signature Requests option to 
enable an internal signee to receive email notification for the E-Signature request created in the 
E-Signatures node. When you select the E-signature Requests option in the User Preferences, 
then Unifier sends an email to the user when an E-Signature request is created for that user in 
the E-Signatures node at company, project, or shell. 

When you select send Notification in Single Daily Digest, and there are notifications relating to 
the E-Signature Requests, then the single digest email to the recipient will contain the 
E-Signature message along with other messages in the email. The header section (where 
hyperlinks to each message within the digest are mentioned) contains the hyperlink to the 
E-Signature message with the text: <Document Name> is sent to you for review and sign. 

Note: You do not have the option to send the document as an 
attachment in the email notification. 

External user

When a Send for E-Signature action is taken, and one or more documents are sent to 
non-Unifier users (External users), the entity that provides electronic signature technology 
(DocuSign or AdobeSign) sends an email to each assignee (one email per document). The 
non-Unifier users can go to the Document Manger log, select a document, and click the Sign 
option from the gear icon to sign the document. This action launches the entity that provides 
electronic signature technology (DocuSign or AdobeSign) and enables you to conduct a 
self-sign. 

The external users are unable to act on the E-Sign task from the email sent out from AdobeSign 
or DocuSign. 

When sending out an E-Signature request, for external users, the question-mark icon in the 
External field of the Send for E-Signature window informs the external user to enter multiple 
email addresses separated by commas or semi-colons and click Send for E-Signature. 

If the external user enters an invalid email address, then: 

 Unifier logs the signee's E-Signature status as Failed, in the E-Signature log. Unifier enables 
the user to mouse-over the status (Failed) and see the reason for failure, for example: 
Mailbox unavailable. Alternatively, the user can also click the gear icon option Reason for 
Failure and see the reason, for example: Mailbox unavailable. 

 If there are only external signees in an E-Sign request, and all of the email addresses of the 
external signees are invalid, then the status of the E-Sign request will be set as Failed in: 

 Document Manager log 

 Attachments tab for BP Upper form, or detail form 

 Attachments Review tab 
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If any of the recipients (external or internal) in the E-Sign request is a valid one, then the status 
of the E-Sign request is based on the status of the valid signees. Unifier ignores the failed 
signee. 

Proxy user

A proxy user can see all of the E-Signature features (E-Signatures Node, E-Signature Status 
column in DM, Send for E-Signature/Self-sign actions, etc.) as they can be seen by the original 
user. If the proxy takes any of the E-Signature actions (Self-sign or Sign an E-Signature request 
from the E-Signatures node), then: 

The grid in the E-Sign Log displays one more column at the very end (Proxy User). The name of 
the proxy user is captured in the this column (similar to the 'Proxy User' column within the Audit 
log of a business process log). Note that this column shows up in the grid only if there has been 
a proxy action by at least one signee within an E-signature request. 

The Signee column shows the original signee's name; however, the exclamation-mark icon (at 
the end of this column) will indicate whether the signature action has been taken by a proxy, or 
not. Hovering at this icon displays: Signed by Proxy User: <Proxy User Name> 

The Proxy User action options are available where E-Sign log can be seen (E-Signatures node, 
DM, BP attachments tab). 

Note: The Proxy users can see the E-Signature count on the Company, 
Shell, and Project home landing pages. 

Project landing page

Similar to the Company and Shell home landing pages, the project landing page shows the 
count of pending E-Signatures in the Items Requiring Your Attention section. The count can be 
seen below the Tasks count as: E-Signatures: <xx> Pending. 

Note: The count is shown only if the E-Signatures are enabled for the 
project. 

Internationalization

The user's language preferences in Unifier is used when the E-Signature requests are sent out 
to external users by way of AdobeSign or DocuSign. For example, if a user's preferred language 
for Unifier is Chinese, then the E-Signature email request that is sent out to an external signee 
by way of AdobeSign or DocuSign will be in Chinese. 

E-Signatures Log 

To access the E-Signatures log, go to your project and click E-Signatures node on the 
left-hand navigator. 

The E-Signatures log has the following tools, options and columns: 

E-Signatures log toolbar 

Field Description 

View The function is similar to the View option available in several other logs in 
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Unifier. The options are: 

 All

 Group By Status

 Create New View

 Manage Views

Edit 
View

The function is similar to the Edit View option available in several other logs 
in Unifier. 

You can use this option to edit the current view (Active View). 

Delete Select one or more tasks and delete. 

You cannot delete incomplete tasks (tasks with Status set as In-Progress). 

If you delete an completed task, then E-signatures log (in Document Manager 
and within a BP record) displays the Status. 

Print The function is similar to the Print option available in several other logs in 
Unifier. The options are: 

 Print

 Export to CSV

 Export to Excel

Search Click to open the Search window at the bottom of the page. 

You can search inside all of the columns available in the E-Signatures log. 

Find on 
Page

The function is similar to the Find on Page option available in several other 
logs in Unifier.  

E-Signatures log columns 

Column Description 

Name The name of the document that has been sent for E-Signature. 

The column displays the file-type (extension) along with the name. 

Note: Since DocuSign converts all files to .pdf, the extension will always be 
.pdf in this column. 

From The name of the Unifier user who initiated the Send for E-Signature action 
(from the Document Manager or from within a BP record). 

Status The status of the E-Signature task: 

In-Progress: When assignee has not yet taken any action on the signature 
task. The default Status of any E-Signature task. 

Completed: When assignee opens the E-Signature task through DocuSign, 
and clicks Continue in the resulting window. The system populates the 
DocuSign fields, available on the left, (Signature, Initial, Date Signed, Name, 
First Name, Last Name, etc.). Assignee clicks Finish at the top to complete 
the signing. 

Declined: When assignee opens the E-Signature task and selects the option 
Decline to Sign. 
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Recalled: The E-Signature task for all signers who have not yet completed 
the E-Signing process are recalled. 

If an E-Signature task has been created by way of Send for E-Signature
action (from the Document Manager), sent to multiple signers, and at least 
one signer declined the task, or 

If an E-Signature task has been created  by way of Send for E-Signature
action (from within a BP record) and that BP record reaches a Terminal 
status.  

In such cases, when a user opens a task, Unifier displays an alert indicating 
that the Status is set to Recalled, and the Completion Date is set to the date 
when the task was recalled. 

Subject The subject of the Send for E-Signature message. 

Docum
ent 
Locatio
n

If the document was sent for signature from the Document Manager, then this 
column displays the Document location in the Document Manager, for 
example: ... /Field Reports/Action Items. 

If the document was sent for signature from a BP record, then this column 
displays the BP record number. 

Receiv
ed Date

The date when the Send for E-Signature task was received by the assignee.

The default sort for this column is Received Date with latest received task at 
the top. 

Comple
tion 
Date

The date when the E-Signature task reaches a Terminal state (Status = 
Completed, Declined, Recalled). 

E-Signatures log right-hand pane 

When you open the E-Signatures log, the top row item is selected by default, and the 
E-Signatures log right-hand pane displays the following tabs: 

Tab Description 

Previe
w

Displays a preview of the document that has been sent for signature. 

If the E-Signature task is in either of following statuses, this pane displays a 
preview of the original document that was sent for E-signature: 

 In-Progress 

 Declined 

 Recalled 

If the E-Signature task is in a Completed status, then this pane displays a 
preview of the signed document. 
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E-Sign 
log

Displays a list of all internal and external users to whom a given document 
(from the Document Manager or from within a BP record) was sent for 
signature through the Send for E-Signature. 

The toolbar options enable you to: 

Print: Print documents 

Download: To download the latest signed signed  copy of the document. 

The columns are: 

Signer: The name of the user who must sign, or has signed, the document. If 
an internal user, then the cell contains the user's first and last names. If an 
external user, then the cell contains the user's email address. 

Sign Status: The e-signature status of the document for the signer. It can be: 
Delivered, Completed, Declined, or Recalled. 

Initiated Date: The date when the document was sent for e-signature. This 
can be the date that an action was initiated by an internal user using the Sign 
option from the gear icon. 

Completion Date: The date when the e-signature task has reached a 
Terminal state (Status = Completed, Declined, Reassigned, Recalled). If a 
signer (internal or external) declines an e-signature task, you can see the 
reason by clicking the signer's entry and opening the Reason for Decline 
block at the bottom of the tab. 

Messag
e

Displays the message sent by the sender, when sending the document for 
signature through the Send for E-Signature. 

E-Signature Log (declining an E-Signature) 

If a signee declines an E-signature request, then the E-Signature log captures the E-Signature 
status as Declined. When the E-Signature Status = Declined, then the tooltip (triggered by 
placing the pointer on the status), or the gear icon options, displays the reason for decline. 

When you select an E-Signature request from the E-Signatures node, you can see the 
E-Signatures log in the right-hand pane (E-Sign Log). The log contains the: 

 Message which was sent out a the time of sending the E-Signature request 

 A log of all e-signature requests statuses. 

When you move the mouse over a row in the E-Signatures log, the gear icon appears and 
enables you to perform the following on a task: 

 Sign: Enables you to open the document and sign or do other reviews. 

 Delete: Enables you to delete a task. You cannot delete an incomplete task (In-Progress, 
Deferred, or FaxPending). 

When you double-click on a row in the E-Signatures log, the sent document opens in the entity 
that provides electronic signature technology (DocuSign or AdobeSign). Follow the prompts and 
when done click Finish to close the application (DocuSign or AdobeSign). 

After you finish signing a document, the E-Signatures log gets updated and the status changes 
to: Completed. At this stage, Unifier updates the E-Signatures log of the module (Document 
Manager or BP record) where the document was sent from and changes the status to: 
Completed. This update process applies to the Completion Date, also. 
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